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includes a full list of Integrations between HP Products, as well as a listing of ITIL Processes. The URL for this website is http://h20230.www2.hp.com/sc/solutions/index.jsp
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Introduction to Service Manager 9.35
HP is continuously improving the 9.3x release series of Service Manager to better serve you until you are
ready to move to the 9.4x release series. Service Manager 9.35 is available as a patch with several
attractive themes. The "What's new in this release" section describes the feature differences between
version 9.35 and 9.40.
Service Manager 9.35 inherits the exciting features of Service Manager 9.34 Smart Analytics, with
enhancements such as the distributed setup of the Image Servers and the use of the Hot Topic
Analytics feature in more modules. With the Smart Analytics features, Service Manager can mine your
data and provide you with graphical reports that help you discover incident trends and identify problem
candidates. You can easily improve the productivity of your IT Service Desk by using the generated
analytical information.
In addition to Smart Analytics, Service Manager 9.35 also incorporates the functionalities of the Case
Exchange content pack and the Mobile Applications content pack, which were released earlier. With the
Case Exchange framework, you can conveniently exchange data between two Service Manager systems
or between a Service Manager system and a Service Anywhere system. For Mobile Applications, now the
Employee Self-service (ESS) functionality is provided. Users can now use a simplified Service Desk
interface to search the knowledge base or submit service requests.
Several enhancements have been made to Service Request Catalog (SRC) in this release, to make the
tool more robust and versatile. For example, now TLS/SSL connections between the Service Request
Catalog web application server and the web browser are enabled by default, which provides you with a
more secure environment. Another example is that now SRC users can filter the Interaction search
results based on the search fields predefined by a Service Manager system administrator.
These great features and more are summarized in "What's new in this release" on the next page. But
that’s not all… the journey of improving overall product quality didn’t stop either: we resolved nearly 270
defects and implemented 14 customer-requested enhancements. And the Service Manager team is
already busy working on the next set of features and product improvements. Stay tuned!
As always, we encourage you to actively participate in making Service Manager better. Please follow us
on Twitter at @HPITSM, join our LinkedIn group "HP ITSM," or join the discussion on our blog.
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What's new in this release
This section describes the important changes in Service Manager 9.35.
The following table describes the prerequisites of the new features in this release and compares the
availability of these features with version 9.40. Before you start to use the new features, make sure the
prerequisites are met. You can also use the feature comparison result as one of the considerations for
Service Manager upgrading.
Feature
Smart Analytics

Prerequisites
l

Service Manager 9.35 Applications

l

Service Manager 9.35 server

l

Service Manager 9.35 client

l

Case Exchange

JRE 8 support

Service Manager 9.35 Applications

l

Service Manager 9.35 server

The following components in Service Manager 9.35
require JRE 8:

l

Mobile Applications
enhancements
Service Request
Catalog enhancements

Yes

Service Manager 9.35 Smart Analytics server
for Linux (64-bit) or Windows (64-bit)

l

l

Available in 9.40

Yes

No

Service Manager 9.35 server
Service Manager 9.35 Windows client and its
Configuration Utility

l

Service Manager 9.35 Applications

l

Service Manager 9.35 Mobile Applications client

l

Service Manager 9.35 Applications

l

Service Request Catalog 9.35

Yes

No

Smart Analytics
Smart Analytics heralds the debut of the "Big Data" edition of Service Manager. Using an OEM-licensed
version of HP IDOL, this powerful Service Manager-IDOL integration drives automation further into ITSM
processes by mining unstructured data and by extracting information from different types of data.
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With the Smart Ticket and Hot Topic Analytics features, Smart Analytics enables Service Manager to
become a more intelligent and efficient system. In addition to the functionalities provided in Service
Manager 9.34 Smart Analytics, Service Manager 9.35 Smart Analytics introduces the following
enhancements:
l

You can install Image Servers in a distributed setup.

l

Hot Topic Analytics is provided for the Service Desk, Incident Management, and Problem
Management modules.

l

The Query Editor is added to Hot Topic Analytics so that you can build complex queries to refine the
intelligent analysis performed by Hot Topic Analytics.

l

You have more tailoring choices (for which corresponding tailoring instructions are provided).

For more information about using Smart Analytics, see the Smart Analytics Administrator and User
Guide.
Note: In this release, Hot Topic Analytics does not support the accessibility features.

Case Exchange
HP Service Manager Case Exchange is a solution that exchanges data between two Service Manager
systems or between a Service Manager system and a Service Anywhere system. You can use the Case
Exchange framework to transfer data between the two integrated systems and view or process the
exchanged data in your native environment.
Service Manager 9.35 includes all the functionality of the Case Exchange Content Pack for Service
Manager 9.34. You can use the Case Exchange framework to set up the following integrations for the
Incident Management module:
l

The integration of two Service Manager systems

Note: The other Service Manager system must be 9.34 that has the Case Exchange Content
Pack applied or later versions.

Service Manager 9.35 includes two integration templates: CaseExchangeSM_SM_Pull and
CaseExchangeSM_SM_Push. These two templates allow you to set up the integration with the other
Service Manager system by using the Pull or Push mechanism. One improvement made in this
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release is the ability to turn on the attachment transferring functionality for both Service Manager
systems when the Push mechanism is used.
l

The integration of Service Manager and Service Anywhere
Service Manager 9.35 provides an integration template: CaseExchangeSM_SAW. This template
allows you to set up the integration with a Service Anywhere system by using the Pull mechanism.

For more information about using the Case Exchange functionalities, refer to the following online help
section:
System Administration > Integrations > Case Exchange framework

JRE 8 support
As Oracle does not provide further updates for Java SE Runtime Environment (JRE) 7, HP Service
Manager 9.35 starts supporting JRE 8. This section introduces the JRE 8 support of different Service
Manager 9.35 components.
l

The Service Manager 9.35 server requires the following upgrades of the embedded JRE.
Server platform

JRE upgrade

Windows

After you apply the Service Manager 9.35 server patch, the embedded JRE
is automatically upgraded to version 8.0.40.

Linux

After you apply the Service Manager 9.35 server patch, the embedded JRE
is automatically upgraded to version 8.0.40.

HP-UX

You need to manually install JRE 1.8.0 or a later version, and make
Server/RUN/jre a symbolic link that points to the JRE 8.

AIX

You need to manually install JRE 1.8.0 or a later version, and make
Server/RUN/jre a symbolic link that points to the JRE 8.
Note: The JRE 8 upgrade supports AIX 7 7100-03 or higher and AIX 6
6100-07 or higher.

Note: Solaris 9 and Solaris 10 do not support JRE 8, so you need to manually install JRE 1.6.0_20
or its later updates for Solaris 9 and JRE 1.7.0_45 or its later updates for Solaris 10, and then
make Server/RUN/jre a symbolic link that points to the JRE 6 or 7.
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l

The Service Manager 9.35 web client requires a 32-bit version of JRE 5 or greater; however, a 32-bit
version of JRE 8 is recommended.

l

The Service Manager 9.35 Knowledge Management Search Engine requires JDK 6 (Update 21 or
greater), JDK 7 (Update 67 or greater), or JDK 8.

l

The embedded JRE version in Service Manager 9.35 Windows client and its Configuration Utility is
upgraded to JRE 8.

See HP Service Manager 9.35 Support Matrix for more information. You can also get more information
about Java SE Runtime Environment from the Oracle website at http://www.oracle.com.

Mobile Applications enhancements
Service Manager 9.35 Mobile Applications introduces the following new enhancements.

Self-service user interface
As of Service Manager 9.35, the Employee Self-service (ESS) functionality that was previously available
through content packs is now incorporated directly into Service Manager. The Service Manager Mobile
Applications self-service user view is intended for end-users as an entry point to Service Desk and
provides a simplified Service Desk interface for users to perform the following tasks:
l

Search the knowledge base

l

Submit a self-service request

l

Submit a smart request

l

View opened and closed tickets

l

View, approve, or deny pending approval requests

For more information on installing and using Service Manager Mobile Applications, see the Service
Manager Mobile Applications User Guide

New mobile operating system support
Service Manager 9.35 Mobile Applications supports iOS 8.x.
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New parameter
The maxRequestPerSecond parameter in the HP Service Manager Mobile Applications configuration file
(web.xml) defines the maximum number of requests allowed per second for one user session from the
Service Manager Mobile Applications client. The default value for this parameter is 10. To allow
unlimited requests, set the value to -1.

New behavior change
When searching the knowledge base in the Service Manager Mobile Applications self-service user view,
the maximum length of the query keyword string is limited to 1024 characters. Any query string longer
than 1024 characters will be truncated to 1024 characters.

Service Request Catalog enhancements
Service Request Catalog 9.35 introduces the following new enhancements.

Enable TLS/SSL connection
To ensure secure data transmission, the default value of the src.security.secureLogin parameter
is set as true to enable a TLS/SSL connection between the Service Request Catalog web application
server and the web browser. If you don't want to enable the TLS/SSL connection, you can set the value
of the parameter to false.
Note: TLS/SSL creates an encrypted connection that allows private information to be transmitted
without the risk of eavesdropping, data tampering, or message forgery. HP recommends enabling
TLS/SSL communication between the Service Request Catalog (SRC) web application server and the
web browser.

Query fields auto-fill
The Lookup fields in the dynamic user options and the Checkout Panel are automatically filled when only
one result is returned.
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Improved ID affiliation
Approvers can view the Request ID and its affiliated Cart Item IDs as necessary, so that it is easy for
them to identify the cart items to be approved or denied.

Advanced search for interactions
Service Request Catalog supports advanced search for interactions.
Administrators can customize the search fields in Service Manager, and then Service Request Catalog
users can filter the search results based on the predefined search fields.

Setting variables as the default values for custom fields
You can use variables as the default values for fields in the Checkout Panel.

Multiple selection for user options
Users now are able to select multiple values (for example, multiple CIs from the device table) in an Item
Option field when they order a catalog item in Service Request Catalog.

View attachments in Change records
Change approvers can view the attachments in the Change approval records when they approve Change
requests.

Copy read-only fields
You can now copy the read-only fields in Service Request Catalog pages, such as the Catalog Item
Details, Request Details, Approval Details, and the Subscription Details pages.
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User option template
Service Manager client users are able to save the existing User Selections in a catalog item as a
template, and then apply the template to one single catalog item or mass-apply it to selected catalog
items.

Primary key feature enabled by default
In Service Manager 9.35, the primary key feature is enabled by default. Therefore, you no longer need to
specify primary_key_mode:1 in the sm.ini file to enable the primary key feature. Additionally, the
primary_key_mode server configuration parameter is now obsolete and is therefore removed. For
example, when you add a key to a dbdict record, the primary key type is always available for selection.
The rest of the primary key feature behaves almost the same way as in previous releases, except that
Service Manager does not convert a unique key to a primary key unless you explicitly change the unique
key to a primary key either in the Service Manager client or by running the system_addconstraint
command.
Note: If you already have the primary_key_mode parameter specified in the server's sm.ini file,
remove it. If you do not do so, an error message is generated in the server log, indicating that the
command could not be recognized.

Note: The updated primary key feature requires Service Manager applications 9.32 or later.

Out-of-box user password policy updated
Compared with previous versions, Service Manager 9.35 uses an updated user password policy to
elevate the protection level for user passwords. This includes adding a default value for some settings
and changing the selected or unselected state of some options.
In general, new passwords now must conform to the following rules.

Setting or option

Default
value/state

Rule

Min Password Length

10

Must contain at least 10 characters.
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Setting or option

Default
value/state

Rule

Max Password Length

128

Must contain no more than 128 characters.

Require Mixed Case

Selected

Must contain at least one uppercase character and at
least one lowercase character.

Require Non-Alpha
Chars

Selected

Must contain at least one digit (0 - 9) or special character.

Min Required

1

Use Time Period

Selected

Max Pwd Lifetime

90 00:00:00

Keep Password
History

Selected

When resetting their password, users are prevented from
using any of the last 10 values.

Prompt for Value

Selected

When resetting the password for an operator using the
Reset Operators Password option, the administrator is
prompted to enter a new password. The system no longer
automatically populates the user's password field with
the user name.

Must expire in 90 days.

New text strings to be localized
This release has introduced a number of new text strings, all of which have been localized except for a
few as listed in the following table. You can easily localize them using the native2ascii tool. For detailed
localization instructions, see knowledge article KM00779834.
The following table lists the text string added in this release.
File

New text string

Description

cpe_web.properties

FileUploadServlet.File_prefix_
illegal=File name contains illegal
characters

This label is for the error log message
that is generated when the name of an
attached file contains characters that
are not permitted.

Certifications
This release includes the following new certifications:
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Service Manager server
Operating system
l

Red Hat Enterprise Linux 6.6

l

Oracle Enterprise Linux 6.6

l

Novell SUSE Linux Enterprise Server 12

Database
l

SQL Server 2014

l

Oracle 12c on HP-UX

Note: In this release, a new installation package (sm9.35.0012_HPUX-IA64-ORCL12C.tar) is
provided so that the Service Manager server running on HP-UX can connect to Oracle 12c.

Service Manager web client
Web application server
l

Weblogic 12c

JRE 8
l

Certified for web application servers that are compatible with JRE 8

l

Certified for all supported browsers

Service Manager Mobile Applications client
Handset
l

iOS 8

JRE 8
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l

Certified for the web application servers that are compatible with JRE 8

l

Certified for all supported browsers

Service Request Catalog
Service Request Catalog for tablets
l

iOS 8

JRE 8
l

Certified for Tomcat

l

Certified for all supported browsers

For more information about the certifications in Service Manager 9.35, refer to the Support Matrix
document.

Other enhancements
Additionally, HP Service Manager 9.35 includes the following enhancements.

Language pack installation
Unlike in previous releases, the language packs for all supported languages in this release are provided
in the same package. By default, the languages that are already installed in your system are
automatically detected and selected during language pack installation. You can change the selections
based on your needs.
For more information, see "Language pack installation" on page 108.

Type of files that are not allowed as attachments
The web client provides additional protection by using a "whitelist" to control the types of attachments
that can be submitted to Service Manager. From the web client, you can submit only attachments of
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which the file types are in this whitelist. In the out-of-box system, this whitelist includes these file types,
which are considered safe: bmp, jpg, jpeg, png, gif, txt, log, unl, and csv.
For more information, refer to the subsections about attachment handling in the Database
Administration section of the Service Manager online help.

Hash code string added to SRC URLs
Starting from Service Manager 9.35, a hash code string is appended to the URLs that are used to access
SRC. This requires the value of sm.hostname in the SRC configuration file applicationContext.properties
to be the same as the host name portion of the queryhashcode parameter in the sm.ini file.
Note: If you use an SRC URL that is generated from a Service Manager version earlier than 9.35 to
access the SRC server, you may fail because the URL does not contain the hash code string. To fix
this issue, SRC administrators can set src.enableQueryHash=false in the
applicationcontext.properties file.
For more information, refer to the Service Request Catalog Interactive Installation Guide in the Service
Manager Installation and Upgrade Documentation Center.

HP Service Manager (9.35)

Page 17 of 111

Release Notes
Applications

Enhancements
This release includes the following enhancement type fixes.

Applications
CR

Problem

Solution

QCCR1E104010 It is not possible to set
variables as default
values of columns in SRC
tailoring.

Now variables and Javascript functions can be used as
the default values in SRC tailoring.

QCCR1E112070 You cannot select
multiple field values in
the item options, and
then save the item.

You can select multiple field values, and then save
them. The system saves the selected values in the cart
items for the potential fulfillment workflow, which you
can implement.

QCCR1E115156 Some time zone settings
are not updated for
2014.

Now the time zone settings are updated for 2014.

QCCR1E115335 SRC does not support
advanced search for
interaction records.

SRC now supports advanced search for interaction
records in the Request Inbox page.
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Documentation
CR

Problem

QCCR1E73872 In the set.search panel of the
svcCat.display.catalog RAD application,
an expression on line 5 hard-codes part
of the query by specifying the
description field as an exact match
(description=). However, if you have a
system in which you have disabled IR
(because of the irdisable:1 parameter,
bugs, performance, or other reasons),
your catalog searches will never return
any matches.

Solution
The following description is added to the
documentation to warn customers:
IR search must be enabled for Service
Catalog search. To enable IR search, set
the ir_disable parameter to 0.
To enable Service Catalog search, the
description and desplayName fields in the
svcDisplay DBDICT are set as the IR key by
default.

Additionally, there is no known issue
warning customers that performing
Service Catalog searches requires IR to
be working, and that the IR key
definition for the catalog must include
the description field.

SRC
CR

Problem

Solution

QCCR1E98633

Appropriate Request ID number and
Cart Item number for each approval
item of which approvers are asked
to provide an approval decision are
not displayed.

Now both the Request ID number and the
Cart Item number can be completely
displayed in the section with the approval
decision buttons.

QCCR1E104010 It is not possible to set variables as
default values of columns in SRC
tailoring.

Now variables and Javascript functions can
be used as the default values in SRC tailoring.

QCCR1E106018 SRC query fields with the query that
returns a single record are not
automatically filled. Instead, you
must fill the field and select the
single record.

The query fields are now automatically filled,
no matter they're mandatory or not. This
mechanism only works when you submit new
requests. It does not work when you
resubmit/update requests.

QCCR1E115335 SRC does not support advanced
search for interaction records.

SRC now supports advanced search for
interaction records in the Request Inbox
page.
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Server
CR

Problem

QCCR1E111419 The dbdict utility does not
support changing the SQL type
from non-unicode to unicode.

Solution
The dbdict utility now supports changing the SQL
type from non-unicode to unicode. The following
SQL type changes are supported:
From varchar to nvarchar (when the length is
not shortened)

l

From char to nchar (when the length is not
shortened)

l

Note: SQL type changes from text to
nvarchar (max) are not supported because
the text type is deprecated in Service
Manager 9.35.

Upgrade
CR

Problem

Solution

QCCR1E110822 The Merge and Mark as Reconciled
buttons for resolving upgrade conflicts are
located in the More... menu and this is
inconvenient.

The "Merge", "Mark as Reconciled",
"Revert", and "Choose Upgrade"
actions are now available as buttons
on the toolbar.

QCCR1E112193 Users can select a base version in the
Upgrade Wizard.

Base version selection in Upgrade
Wizard is disabled.

QCCR1E112620 The replaced RAD does not have the PRE
prefix after the upgrading.

The replaced RAD now has the PRE
prefix.

QCCR1E114153 After you click the Apply an Upgrade
button, the upgrade path can be changed.

Now the upgrade path can no longer
be changed in this case.
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Web client
CR

Problem

Solution

QCCR1E98987

Oracle Weblogic 12 is not
certified for Service Manager
Web Tier.

Oracle Weblogic 12 is now certified for Service
Manager Web Tier.

QCCR1E112070 You cannot select multiple field
values in the item options, and
then save the item.

You can select multiple field values, and then
save them. The system saves the selected values
in the cart items for the potential fulfillment
workflow, which you can implement.

QCCR1E119906 Mozilla Firefox 31 is not certified Mozilla Firefox 31 is now certified for Service
for Service Manager web client. Manager web client.
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Fixed defects
This release fixes the following defects.

Applications
CR

Problem

Solution

QCCR1E113230 You cannot use the keyboard to remove
an item from the Delivery Objectives
table.

You can now use the keyboard to
remove the item.

QCCR1E31634

You cannot add security folders for
known error tasks.

Now you can add the security folders.

QCCR1E58958

On the Polish version of Excel 2003 or
2007, the .csv files exported via the
"Export to Text File" functionality of the
Windows client displays corrupted
characters.

Exported files can now be displayed
correctly.

QCCR1E96094

You cannot update the catalog
information in an Interaction after you
resubmit the request.

You can update the catalog information
in an Interaction after you resubmit the
request.

QCCR1E97513

No approval log is displayed for line item
approvals in the Interaction record UI.

Approval logs are displayed for line item
approvals in the Interaction record UI.

QCCR1E97845

When you try to use a view that was
generated from the workflowphase
table, an error occurs.

You can generate views from the
workflowphase table as expected.

QCCR1E97981

The "Open an Incident" connector does
not work in the service catalog module.

The connector now works properly.

QCCR1E101272 If you enter some information in the
"Update Comments" field of a Knowledge
Management document, and then
publish the document internally or
externally, the comments entered are
not saved. Additionally, no update record
is created in the "activityKMDoc" table.
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CR

Problem

Solution

QCCR1E102369 The recurring cost of a bundle is not
The recurring cost of a bundle is
displayed on the Interaction details page. displayed on the Interaction details
page.
QCCR1E103257 When a problem management task is
closed before its scheduled expiration
time, a "past due" notification is
unexpectedly sent.

Now the notification is no longer sent.

QCCR1E105012 The filters don't work if a view is
selected in the Search form.

The filters now work properly.

QCCR1E105608 After you apply Service Manager 9.21
Application Patch 3, some fields are
added as the "intType" type in the
"extaccess" table for some objects, such
as "Change" (name=cm3r). Therefore,
the web service no longer works
correctly until you remove this added
entry.

Now the web service works properly.

QCCR1E106767 In a multiple language environment, cart
items are not displayed in the language
that the you use to log in.

Now items are displayed in the correct
language.

QCCR1E106769 The system is slow when you click order
from catalog in a load-balanced
environment.

The system response is now faster in
this situation.

QCCR1E107094 After you use a custom change model
that has tasks created in the Task
Planner to create a change record, only
the last task created in the planner can
be seen by the assigned group in the "To
do" queue; other tasks cannot be seen
unless the record is created and saved.

All the tasks can now be seen in the "To
do" queue.

QCCR1E107540 Validations used for "interaction to
incident" escalation do not always work
correctly.

Now these validations work correctly all
the time.

QCCR1E107508 Update notifications of incidents are not
processed by Javamail when the event
class batch size is larger than zero.
Therefore, many "eventout" records are
generated.

Now validations are added to avoid the
situation.
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QCCR1E108699 The target order and target completion
dates are incorrect in the dependent
groups of a Request.

The date is now correct in the
dependent groups.

QCCR1E108989 The BSGFunctions JavaScript can cause
user sessions to consume 100% of CPU
resources.

The BSGFunctions JavaScript works as
expected.

QCCR1E108990 The usage of Request Management
license is not calculated correctly for
users who have "view only" rights.

User who do not have "update" rights
for the Request Management module
do not consume a license.

QCCR1E109439 After an incident record is closed, the
SLO status is breached before the
expiration time is reached.

Now the SLO status is not breached
before the expiration time is reached.

QCCR1E109655 The "cirelationship" trigger takes a long
time to add a new child to a large CI (that
is, a CI with many sub-CIs).

The performance for the
"cirelationship" trigger is now improved.

QCCR1E109618 When you edit a CI and then click Save &
Exit, the form is closed to further editing
even if field validation fails.

The form is not closed to editing if field
validation fails.

QCCR1E109754 When you select Custom sort to sort the
interactions in the interaction list page,
the list is no longer sorted after you
refresh the page.

The list is still sorted after the page is
refreshed.

QCCR1E109843 If two threads address a CI or its
relations, and one removes a
relationship, the other thread may not
display the relationship changes
accurately.

Please refer to the documented
Workaround. HP does not plan to
implement further changes to fix this
issue.

QCCR1E110479 When the number of affected CIs for a
query string exceeds 64, you receive an
error message.

When the number of affected CIs for a
query string exceeds 64, you receive a
"Too many child element" message
instead of the application error
message.

QCCR1E110537 If you apply a default template to change
categories with the Folder Entitlement
functionality enabled, an error is
generated when you try to create a new
change that belongs to one of those
categories.

Now no error is generated.
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QCCR1E111031 The customized accessible description
for the recordlist table in a wizard
cannot be read by JAWS.

The description can now be read by
JAWS.

QCCR1E111067 The order of the elements in the source
code does not match the logical or visual
order of the elements in the wizard
form.

The order of the elements in the source
code matches the logical or visual order
of the elements in the wizard form.

QCCR1E111285 When multiple SLOs are defined in an
SLA, and then the SLA record is
suspended, the SLOs are incorrectly set
to "achieved." Additionally, the incorrect
or the last SLA is set to "suspended."

Now a new "Use Legacy Unordered
Suspend Process" option is provided to
support the legacy unordered
suspended processes.

QCCR1E111359 It takes the system a long time to
perform the SLA calculation when there
are empty IDs in the SLO responses.

Now the SLA calculation is optimized.

QCCR1E111325 The "Initial state" and the "Final state" of
the "slo.qbe" list display incorrect values
compared to the initial and final state of
the same SLO in the "slo.view" list.

The values displayed are now correct.

QCCR1E111414 In SRC, the Category, Area, and Subarea
fields of registered interaction records
are not localized for end users.

The fields are now localized in SRC.

QCCR1E112009 An unrecoverable error occurs and
Applications Patch Manager stops
running when you apply Applications
Patch Manager to a database two times.

No error occurs when you apply
Applications Patch Manager to a
database two times.

QCCR1E112179 The verifyChangeCategory function in
the "changeManagement" Scriptlibrary
does not validate the category for
change tasks correctly.

The function now validates the category
for change tasks correctly.
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QCCR1E112510 After you import CIs to the
"cirelationship" table and then browse
the list of CIs, you receive the following
error message:
Script 'ciVisualizationGraph'
line 827: ERROR out of memory at
char 1) and (Script
'ciVisualizationGraph' line 804:
ERROR TypeError: to has no
properties at char 1)
Additionally, Service Manager
stops responding.

Solution
The root cause for this issue is a CI
record that does not exist in the
"cirelationship" table. When the system
searches for related CI records based on
the CI relationship, it encounters an NPE
issue. Please refer to the documented
workaround. HP does not plan to
implement further changes to fix this
issue.

QCCR1E112790 When you select a lot of change records
to Mass Approve, the popup box is
populated for each record if you belong
to more than one group.

When you select a lot of change records
to Mass Approve, the popup box is
populated once.

QCCR1E112736 Permission to create a new Time Period
incorrectly depends on the Change
Management license. No license check
should be performed when you create a
new Time Period.

License dependencies are removed
from the Time Period module.

QCCR1E112858 After you try to close an incident by using After you try to close an incident by
the web services, a "success" message is using the web services, a "success"
returned even if the task fails.
message is not returned if the task
fails.
QCCR1E112917 When you order a catalog item bundle
that has dependencies defined at the
model level, the values for the fields
group.parent, dependency.type, and
vendor.time.zone are missing. However if
the same item is selected when you open
a quote manually, all the values are
populated as expected.

When you create quote records in
different ways, the values for the fields
group.parent, vendor.time.zone, and
dependency.type are filled with
consistent values.

QCCR1E113237 When you create a new Incident in multicompany mode, the Company field is not
automatically populated.

When you create a new Incident in
multi-company mode, the Company field
is automatically populated.

QCCR1E113420 The color bar of the entry record is
missing in the full calendar when the "."
character is set as the date separator.

Now the date separator from the
"tzfile" is used and the color bar is
displayed properly.
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QCCR1E113461 When a bundle is ordered several times
and the quote is moved to the next
phase, the line items should be updated
for all bundles. That is to say, if one of
the items in the bundle changes its
status to "Ordered", in all the bundles in
the quote the status of that item should
be changed to "Ordered" as well.

Now the status of the items is updated
properly.

QCCR1E113446 After you apply the 9.34 applications
patch to a Process Designer Content
Pack 4-enabled l10n environment, a
rename record is created for the
"System Administration" menu item.

No rename record is created after you
apply the 9.34 applications patch to a
Process Designer Content Pack 4enabled l10n environment.

QCCR1E113598 When users request an item from the
service catalog, a service desk record
and a quote record are created. During
this process , 9 line items, instead of 6
line items, are created based on the
dependencies configured.

Now no duplicate line items are created.

QCCR1E113752 When a Business Service with a large
number of related CIs is selected, the
Service Manager servlet does not work
properly and eventually terminates.

Now the system performance is
improved when a CI record is displayed.

QCCR1E113916 An error occurs after you execute the
"PurgeOutofBoxData" unload script.

No error occurs after you execute the
"PurgeOutofBoxData" unload script.

QCCR1E114212 After the subscription changes are
opened, errors are found in the Service
Manager log.

After the subscription changes are
opened, no errors are found in the
Service Manager log.

QCCR1E114225 The device Format Control contains
conditions for JavaScript code that is
now removed.

The redundant code is removed from
the device Format Control conditions.

QCCR1E114340 When you enable the attachmenthandling feature in two Service Manager
systems that are integrated by using
Case Exchange, an endless loop of
attachment exchange occurs.

When you enable the attachmenthandling feature in two Service Manager
systems that are integrated by using
Case Exchange, attachment exchange
works as expected.

QCCR1E114595 When you open a KM document from
SRC, the document is incorrectly
formatted.

KM Documents are correctly displayed in
SRC.
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QCCR1E114694 The system incorrectly notifies you that
a Change task is in conflict with a time
period because the affected service for
the Change task is empty and therefore
differs from the affected service of the
time period.

This is a cache issue. Now additional
logic is added and there are no longer
any conflicts.

QCCR1E114798 There is an Exception error when you
save the format control "probsummary".

Now the format control can be saved
successfully.

QCCR1E114821 You cannot create a new bundle in SRC if
you try to add the "open an incident"
connector as a new item.

Both the bundle and the item are
created as expected.

QCCR1E114967 When you use the dot (".") character as
the date separator, the change calendar
routines fail.

The change calendar routines no longer
fail when you use the dot (".") character
as the date separator.

QCCR1E115009 Changes are not displayed on the
calendar with the color that is defined in
the "Color Preference" conditions.

Changes are displayed on the calendar
with the color that is defined in the
"Color Preference" conditions.

QCCR1E115071 Some data that should be purged by the
PurgeAll and PurgeOutofBoxData unload
scripts is missing from the scripts.

The missing data is added to the
PurgeAll and PurgeOutofBoxData unload
scripts.

QCCR1E115006 An error message is displayed if you
open the change detail form when there
are conditions in the active change
embedded calendar configuration.

Now no error message is displayed.

QCCR1E115244 The calculation for
"approvaldel.show.groups" in Format
Control is not correct.

The calculation is now correct.

QCCR1E115344 Usage conditions do not work for Time
Period categories.

Now the application can evaluate the
usage condition based on different
contexts.

QCCR1E115443 In the Process Designer environment, the
ID of the "Calculate Time Period" option
is the same as the ID of the "Approval>Approval" option.

Now the IDs are different.

QCCR1E115582 When orders are created, the
"rmo.create.order" operation does not
check all the line items.

Now all line items are checked.
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QCCR1E115641 When you set a relative value in an array
of a date/time field in a template, the
value is not correctly applied to Incident
records.

The values are now transformed to
absolute dates and thus the value can
be correctly set.

QCCR1E115756 When you try to automatically fill the
Group/Operator field in the
Approvals/Review tab of a Task Phase
record, you receive an error message.

You can automatically fill the
Group/Operator field in the
Approvals/Review tab of a Task Phase
record as expected.

QCCR1E115821 You can switch to another Change
approval before you have approved all of
the pending child approvals in the
current one.

When you try to switch to another
Change approval before you have
approved all of the pending child
approvals in the current one, the view
remains in the current approval.

QCCR1E115813 The format control "rootcause" calls the
JavaScript function lib.rcaCI.affectedCI ()
twice.

Now the duplicate JavaScript call is
removed.

QCCR1E115857 The title "Change Calendar" is used in the
incident "IM.close.incident" form.

Now the title is corrected.

QCCR1E116050 It takes a long time for the system to
display a Relationship Graph and you
cannot expand CI groups in the graph
once it is displayed.

Now it takes less time for the system to
display a Relationship Graph and the CI
groups can be expanded correctly.

QCCR1E116148 When you move to another output event
without making changes to the current
record, a message box is displayed
asking whether you want to save your
changes.

Now no message box is displayed if no
update is made to the current record.

QCCR1E116240 The text import wizard uses the octal
numeral system.

The text import wizard now uses the
binary numeral system.

QCCR1E116427 The handle time is longer than the open
time when you create an Interaction
record.

The handle time equals the open time
when you create an Interaction record.
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QCCR1E116654 You cannot load an unload file, and you
receive the following error message:

Solution
The file is loaded successfully and you
do not receive any error message.

Process panel merge.sql.mapping
in RAD file.load encountered
error in line 1
(file.load,merge.sql.mapping)
Cannot evaluate expression
(file.load,merge.sql.mapping) Bad
arg(2) oper =
(file.load,merge.sql.mapping)
Cannot evaluate expression
(file.load,merge.sql.mapping)
Script 'xmlHelpers' line 117:
ERROR TypeError: element has no
properties at char 1
QCCR1E116696 When a catalog item has an "All must
Approve" and a "One must Approve"
request level approval, the "One must
Approve" approval does not work (that is
the request is still in the "pending" state
after one of the approvers has approved
the request).

All the approvals work as expected now.

QCCR1E116922 Service Manager does not generate SRC
URLs for line item level approvals
correctly.

Service Manager generates SRC URLs
for line item level approvals correctly.

QCCR1E117178 It takes a long time for the system to
display a Relationship Graph and you
cannot expand CI groups in the graph
once it is displayed.

Now it takes less time for the system to
display a Relationship Graph and the CI
groups can be expanded correctly.

QCCR1E117167 When you add a link from a record in the
KM document reference editor to
another record, you receive the following
message:

When you add a link from a record in the
KM document reference editor to
another record, you receive the
following message:

$L.object.name "x" updated.
QCCR1E117294 After recalculation, the message is
"Recalculation of the time period
confliction completed." The message
should be changed to "Recalculation of
time period conflicts complete".
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QCCR1E117314 Alert are not generated when an
Interaction is updated by the Linker
process.

Alerts are generated when an
Interaction is updated by the Linker
process.

QCCR1E117775 In a French localized system,
"UNSUSPENDED" is displayed in English in
the update.action field when an incident
is unsuspended.

The message is localized to French.

QCCR1E117801 The ApprovalDelegationGroups functions
only work for individual modules. The
functions do not work for all modules.

The ApprovalDelegationGroups
functions now work for all modules.

QCCR1E118158 Service Catalog user selections are not
stored correctly for each localization.

Service Catalog user selections are
stored correctly for each localization.

QCCR1E118307 When you add an attachment to a record
and then save another record (a join file)
that has the same unique key, the
attachment is removed from the original
record and added to the join file.

When you add an attachment to a
record and then save another record (a
join file) that has the same unique key,
the attachment remains attached to
the original record.

QCCR1E118359 Query authorization is not implemented
Query authorization is implemented for
for some RESTful APIs. For example,
all RESTful APIs.
some users can perform all RESTful
requests, regardless of their permissions
for UCMDB APIs.
QCCR1E118452 A "Please provide an update" message is A "Please provide an update" message is
incorrectly displayed when you retract an no longer displayed when you retract an
approval.
approval.
QCCR1E118443 You can switch to another Change
approval before you have approved all of
the pending child approvals in the
current one.

When you try to switch to another
Change approval before you have
approved all of the pending child
approvals in the current one, the view
remains in the current approval.

QCCR1E118590 UserOptions are not displayed as
mandatory fields in the web client.

UserOptions are displayed as mandatory
fields in the web client.

QCCR1E118637 When you order a Support Catalog item
in SRC after tailoring SRC to display the
full name, the contact for this request is
not set correctly in Service Manager.

When you order a Support Catalog item
in SRC after tailoring SRC to display the
full name, the contact for this request is
set correctly in Service Manager.
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QCCR1E118702 When scheduled maintenance objects
are configured to be created only inside
or only outside a specified working
schedule, the default time zone is
always.

The time zone is considered when tasks
are created only inside or only outside
the working schedule.

QCCR1E118765 The "Current Stock" heading is not
formatted correctly.

The "Current Stock" heading now uses
the "header level 2" style.

QCCR1E118787 When you apply the "Service=" filter to
the Change Calendar, a list of records in
which the service is named "All" is
displayed, instead of a list of records for
all services. The same issue occurs when
you apply the same filter to locations,
departments, and environments.

When you apply the "Service=" filter to
the Change Calendar, all records are
displayed.

QCCR1E118992 When you double-click the approval log
in an Interaction form to view the
detailed approval log information,
nothing happens.

When you double-click the approval log
in an Interaction form, the detailed
approval log information is displayed.

QCCR1E119092 When you enter an invalid department
name in a non-English version of Service
Manager, "Invalid Department
Requester" is displayed in English.

The string "Invalid Department
Requester" is no longer hard-coded.
When you enter an invalid department
name in a non-English version of Service
Manager, a localized version of the
message is displayed.

QCCR1E119256 When you resubmit a pending request,
the recurring cost is not updated.

When you resubmit a pending request,
the recurring cost is updated.

QCCR1E119300 You cannot set the value of a field in a
template if this field value depends on
another field value.

You can set the value of a field in a
template even if this field value
depends on another field value.

QCCR1E119371 When you update a CI relationship
record, the uCMDB ID is not updated in
the cirelationship1to1 file.

When you update a CI relationship
record, the uCMDB ID is updated in the
cirelationship1to1 file.

QCCR1E119365 Interactions that have "Telephone"
notification types are not moved to the
"Callback" status when the related quote
is closed.

Interactions move to the correct status
when the related quote is closed.

QCCR1E119363 When you resubmit a Request in SRC and
update the contact details, the contact
for the request is not updated correctly
in Service Manager.

When you resubmit a Request in SRC
and update the contact details, the
contact for the request is updated
correctly in Service Manager.
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QCCR1E119336 When you double-click the approval line
in an Interaction record to view the
approval details, nothing happens.

When you double-click the approval line
in an Interaction record, the approval
details are displayed.

QCCR1E119409 When you use double separators (| |) to
insert multiple hard breaks (blank lines)
into the description(action field) of
probsummary in an eventin record, the
last double separator is not converted to
a hard break.

When you use double separators (| |) to
insert multiple hard breaks (blank lines)
into the description(action field) of
probsummary in an eventin record, the
last double separator is converted to a
hard break as expected.

QCCR1E119403 The value of the first.call field in the
incidents table changes to "false" if the
Interaction is submitted by using SRC.
The value stays "false," even if the same
operator closes the Interaction by using
the Windows client. If the Interaction is
submitted by using the Windows client,
and if the Interaction is closed by the
logged-on operator, the value of the
first.call field remains "true."

The value of the first call field is set to
"true" after an Interaction is submitted
by using SRC. The behavior of ESS and
the web client is consistent.

QCCR1E119475 The rmo.create.order RAD expression
creates multiple order records for line
items.

The rmo.create.order RAD expression
creates only one order records for each
line item.

QCCR1E119618 When Case Exchange transfer an
Incident that has Spanish characters in
the description from SAW to Service
Manager, the Spanish characters are
displayed incorrectly in Service Manager.

The Spanish characters are displayed
correctly in Service Manager.

QCCR1E119676 The Change process does not release the
lock on a Change record.

The Change process does releases the
lock on a Change record.

QCCR1E119678 After you apply the workaround that is
described in QCCR1E117801, you no
longer receive "Approval Added"
notifications.

The notification configuration of the
checkDelegation function supports now
Approvals and other objects (such as
cm3r and timeperiod).

QCCR1E119980 When you open a Change from the
Service Request Catalog and view the
quote details, the value in the Date/time
field of the user options is formatted
incorrectly.

When you open a Change from the
Service Request Catalog and view the
quote details, the value in the Date/time
field of the user options is formatted
correctly.

QCCR1E120116 Dates in the user options of bundled
items are not formatted consistently.

Dates in the user options of bundled
items are formatted consistently.
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QCCR1E120561 When you open a Request from the
Service Request Catalog and view the
quote details, the value in the Date/time
field of the user options is formatted
incorrectly.

When you open a Request from the
Service Request Catalog and view the
quote details, the value in the Date/time
field of the user options is formatted
correctly.

QCCR1E120609 Suppose that you have submitted a
request that contains multiple items.
Each item has a recurring cost. If the
recurring cost value is 0 for any item
except for the first and last one, the
following error message is displayed
when you view the submitted request:

You can now view a submitted request
successfully without any error, even if
the request contains special items.

<Retrieving *** from the server
failed. Try again.>
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QCCR1E120959 When you try to upgrade Service
Manager, the upgrade fails and the
following errors are generated when you
apply a production patch:

Solution
Application Patch Manager now applies
production patches successfully when
NULLTABLE is defined in the updated
dbdict.

24946( 45269) 02/12/2015 14:36:00
RTE E Error: SQL code=1741
message=ORA-01741: illegal zerolength identifier 24946( 45269)
02/12/2015 14:36:00 RTE E API =
OCIStmtExecute [in sqociExecOne],
Statement = CREATE TABLE /*P4
[HPPCHRELassignment; n1;
oracle11; ; Tot bytes: 0]*/
HPPCHRELASSIGNMENTN1 /*
Tconstraints */ ( /*P4[name; 1;
m1; 0]*/ "NAME" VARCHAR2(60)
NULL, /*P4[assignment2; 2; n1; 0]
*/ "" NULL, /*P4[assignment3; 3;
n1; 0]*/ "" NULL, /*P4
[reassignment; 4; n1; 0]*/ ""
NULL, /*P4[calendar.name; 7; n1;
0]*/ "" NULL, /*P4[duty.hours; 8;
n1; 0]*/ "" NULL, /*P4
[printer.name; 9; n1; 0]*/ ""
NULL, /*P4[type; 10; n1; 0]*/ ""
NULL, /*P4[format; 11; n1; 0]*/
"" NULL, /*P4[reassign; 12; n1;
0]*/ "" NULL, /*P4[route.to; 13;
n1; 0]*/ "" NULL, /*P4[route.if;
14; n1; 0]*/ "" NULL, /*P4
[oti.name; 20; n1; 0]*/ "" NULL,
/*P4[oti.assignment; 21; n1; 0]*/
"" NULL, /*P4[time.zone; 22; n1;
0]*/ "" NULL, /*P4[initial.acr;
51; n1; 0]*/ "INITIAL_ACR"
VARCHAR2(60) NULL ) STORAGE
(INITIAL 4K)
QCCR1E121141 Automatic approval (when the
"Preapprove on Open" option is set to
"true") does not work for Service Desk
interactions. The interaction remains in
the "Pending Approval" status.
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QCCR1E121452 The approval status of an Approval
record is displayed as "Pending" when
the record is approved in the Interaction
record.

The approval status of an Approval
record is displayed as "Approved" when
the record is approved in the Interaction
record.

QCCR1E115953 It is not a good solution to use the
trigger "timeperiod.conflict.notification
.after.change.approved" to send emails
when a change conflicts with one of the
TPs.

Now the trigger is removed and the mail
notification is moved into
"cm.update.save", which is called during
the approval process.
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QCCR1E78368

The Applications Patch Manager
Guide for Content Releases does not
correctly describe the View/Merge
Results process.

The Applications Patch Manager
guide is now updated by removing
the information regarding the
Merged result, which should not be
used.

The Applications Patch Manager
Guide for Content Releases suggests
the following:
"The XML for the new object is shown
on the left side, and the XML for your
tailored object is shown on the right
side with the differences highlighted.
5. For simple objects and elements,
use the arrow [...].
6. Click SAVE.
7. Change the Result to Merged and
then click Save.
8. Test the updated functionality of
the merged object.
9. When you are satisfied that the
object is working correctly, rightclick the detail page and then click
Mark as Reconciled in the drop-down
menu."
However, the option of "Mark as
Reconciled" is only available for
those entries with a result of
"Renamed."
QCCR1E84547
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The IR search functionality is not
supported for the Arabic language.

The IR search is not supported for
the Arabic language. You can use
Solr instead.
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QCCR1E100549

The Operations Orchestration
integration documentation in the
online Help incorrectly describes the
location of the keystore during the
integration of Service Manager 9.31
and Operations Orchestration 10.01.

Added the following note to the
"Enable SSL connection from
Service Manager to Operations
Orchestration" topic in the
Operations Orchestration
integration documentation in the
online Help.
Note: If your Operations
Orchestration system does
not contain any keystores in
these folders, skip this task.

QCCR1E112167

In the online Help, the Incident
Exchange (OMi - SM) integration is
incorrectly referred to as the
"SMOMi integration" or "OMi
integration," which is not the official
name of the integration.

Updated the integration name to
"Incident Exchange (OMi - SM)
integration."

QCCR1E115563

Some subphases in the process of
running an out-of-box upgrade need
to be modified or removed from the
Upgrade Guide.

The subphases in the process of
running an out-of-box upgrade are
updated in the Upgrade Guide.

QCCR1E115890

The RAD function strraw() that
exports array data to a delimiterseparated string is not documented
in the Programming Guide.

This function is now documented
in the Programming Guide.

QCCR1E115898

The information is incomplete in help Added information about the help
topic "Add or edit help records". It
review process.
does not state that new or revised
help records must be reviewed
before they can be published.

QCCR1E119101

The documentation for the Oracle CI
mode does not reflect the new
method about using the sqlupper:1
parameter.
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sqlupper:1 feature to the "Oracle
case sensitivity" topic in the online
Help and the database preparation
section in the Interactive
Installation Guide.
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QCCR1E119574

The cursor.field.contents function
does not return any focused content
when a row in a record list is
selected in the Web client.

The description of the function is
updated in online Help and
Programming Guide to indicate
that this function does not support
record lists in the Web client.

QCCR1E119928

In the Service Manager Interactive
Installation Guide, there is no
documentation about deploying the
web tier on WebSphere 8.5.

Updated the Interactive
Installation Guide to include
information about deploying the
web tier on WebSphere 8.5.

QCCR1E120030

Description for the parameter
querysecurity in sm.ini is not correct
in the online Help.

Now the description is correct in
the online Help.

QCCR1E120772

Some workflow diagrams in the
Knowledge Management section of
the Processes and Best Practices
Guide are incorrect or inconsistent
with the description in the
corresponding tables.

The workflow diagrams have been
corrected in the Knowledge
Management section of the
Processes and Best Practices
Guide.

Integrations
CR

Problem

Solution

QCCR1E94259

You cannot enable the OMi event drilldown function when the querySecurity
parameter is set to "true."

The OMi event drill-down function
works as expected when the
querySecurity parameter is set to
"true."

QCCR1E102297

In a UCMDB integration, updates to the
cirelationship table generate duplicate
key errors if no valid ddmRule is found
for the cirelationship table.

The cirelationship table can be updated
successfully in UCMDB integrations.

QCCR1E112495

Case exchange hangs when it
processes inbound requests after
running four hours of benchmark
testing.

Now Case Exchange no longer hangs in
this case.

QCCR1E119644

When you use the pull mechanism of
Case Exchange in Service Manager and
log in to the system with Spanish
enabled, no Case Exchange widget is
displayed in the incident detail page.

Now the Case Exchange widget is
displayed in the incident detail page in
this case.
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QCCR1E119458

The cost of an item is not displayed
when a session is opened in the French
language environment.

Now the cost of the item is displayed.

Mobility
CR

Problem

Solution

QCCR1E113749

The background colors of the two
buttons are similar to those of their
container so they are not easily
distinguished in the drop-down list of
the language combo box in the Mobility
applications.

The background colors are now
different and the buttons are easily
distinguished in the drop-down list of
the language combo box.

QCCR1E114216

Employee Self-service users cannot log
in to Service Manager by using the
Mobile Applications client when TSO is
enabled.

Employee Self-service users can
successfully log in to Service Manager
by using the Mobile Applications client
when TSO is enabled.

QCCR1E115183

The out-of-box template for a
Knowledge Management
Problem/solution article is incorrect.

Now the template is correct for
Problem/solution articles.

QCCR1E115236

The content of a Group control is not
The content of a Group control is now
displayed in some conditions. For
displayed in all conditions.
example, if you add a Group control in a
subform and use the subform in
another Group control or a Notebook
tab, the content of the Group inside
the subform is not displayed when the
form is displayed in Mobile
applications.

QCCR1E115350

When you rotate the screen of an iOS
device, the drop-down menu and the
attachment feature do not work
correctly if the iOS toolbar shows.

HP Service Manager (9.35)

The drop-down menu and the
attachment feature now work as
expected.
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QCCR1E115494

When you retract an approved Change,
the warning message that is displayed
is not user friendly.

The warning message that is displayed
is now correct.

QCCR1E117264

When you cannot log in to the Mobile
client because the maximum number
of concurrent sessions is reached, the
Mobile client does not display the
correct message.

Now, the login error message is
retrieved from the server, and the
correct message is displayed.

QCCR1E117258

After you approve a pending change
approval record, the "My Pending
Approvals" list view remains empty.

Now the "My Pending Approvals" list
view is refreshed correctly.

QCCR1E117606

When a Change Approval record is
displayed with a long Approval group
name, the change ID column is not
visible.

The Change ID column is moved so that
the Change ID is visible even if the
Change Approval record has a long
approval group name.

QCCR1E117640

If you switch languages to log in to the
Mobile Applications client many times,
the languages are mixed in the ESS KM
search page.

The language of the ESS KM search
page is displayed correctly now.

QCCR1E117880

Long text strings are not displayed
correctly in the Employee Self Service
approvals inbox.

Long text strings in the Employee Self
Service approvals inbox now end with
three dots instead of being truncated
suddenly.

QCCR1E118007

The favorite icon of the Mobility
Applications is the same for both the
Employee Self-service mode and the
Standard mode.

Now the favorite icons are different for
the Employee Self-service mode and
the Standard mode.

QCCR1E119775

If Lightweight Single Sign-On (LW-SSO)
is enabled on the Service Manager
server and the Mobile Applications
client, after you log in with the Mobile
Applications client, a blank page is
displayed with an "Internal Server
Error" error message.

Now the main page is displayed
successfully without any error
messages.

QCCR1E119982

The title is not completely displayed in
the Request details page even though
you scroll the screen.

The user interface is modified and the
title can be completely displayed.
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QCCR1E65181

In the System Status screen, no
Device ID is displayed when you
logged in from the Service Request
Catalog client.

In the System Status screen, Device ID is
displayed as WS-SRC in this case.

QCCR1E93720

If an interaction is created in
Service Manager, the operator in
the Callback Contact field cannot
see the ticket in SRC.

Callback Contact of an interaction now has
the ability to see the interaction in SRC.

QCCR1E101538 Links to other Knowledge
Management systems do not work
in SRC.

Now the links work in SRC.

QCCR1E101823 In the Contact Search pop-up
window, the Tab key does not work
properly in Internet Explorer. For
example, if you set focus to the
First Name field and press Tab, the
focus goes to the Contact Name
field. If you press Tab again, the
focus goes back to the First name
field and the Last Name field does
not have a chance to get focus.

In the Contact Search pop-up window, the Tab
key now works properly in all supported
browsers. Each focusable control in the form
can get the focus and you can navigate
through each control using the Tab key.

QCCR1E111414 In SRC, the Category, Area, and
Subarea fields of registered
interaction records are not
localized for end users.

The fields are now localized in SRC.

QCCR1E114551 Downloading catalog item
attachments does not work.

Now the attachments can be downloaded
successfully.

QCCR1E114854 The message for loading category
failure is not user-friendly.

Now a clear message is displayed.

QCCR1E115305 Categories are also displayed in the
auto-complete suggestion list, and
clicking on a suggestion that is a
category does not take you to the
category screen.

Categories are not displayed in the autocomplete suggestion list now.
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QCCR1E115303 Clicking on a suggestion that
includes several words performs an
“OR-search” that does not show
the most relevant results at the
beginning of the page.

Now the most relevant results are displayed.

QCCR1E119471 Some screenshots and tables in
SRC Customization Guide are not
correct.

The screenshots and the tables in SRC
Customization Guide are corrected now.

QCCR1E120123 The configuration of a custom field
in the Service Checkout Panel is
overwritten when there's another
custom field that has the same
name in General Support Checkout
Panel.

Now different custom fields that have the
same name do not overwrite each other
incorrectly.

QCCR1E120535 The name of the delegation
approver can't be fully displayed on
the delegation detail panel.

The name can now be fully displayed on the
delegation detail panel, and if the name is too
long, it is displayed in multiple lines.

QCCR1E120787 When a launcher is created with a
long name in SRC, the title gets
truncated and the result is that
only part of the text is displayed.

Now the title is displayed as a tip when the
mouse is hovered over it.

QCCR1E121115 The item description in the SRC
catalog detail screen contains
many extra spaces between lines
or paragraphs.

Now the item description is displayed
correctly without extra spaces.

QCCR1E121316 A loading spinner is displayed when Now the loading spinner is removed.
you type in the user selection field
(which has dynamic dependency
configured) in the request page. It's
unnecessary and not user-friendly.
QCCR1E121320 On an iOS tablet, the input widget
of the user selection ignores the
first character that you type when
the field is mandatory and
highlighted in the yellow color.

Now the first character typed won't be
ignored in this case.

QCCR1E122019 In the Service Request Catalog
Tablet, the Request Inbox does not
fully occupy the screen when
there's no record in the inbox.

The Request Inbox now fully occupies the
screen.
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QCCR1E65181

In the System Status screen, no
Device ID is displayed when you
logged in from the Service
Request Catalog client.

In the System Status screen, Device ID is
displayed as WS-SRC in this case.

QCCR1E75931

You cannot add an attachment
immediately by using the "Delay
Assigning Interaction Ticket"
option.

Now you can add an attachment immediately
by using the option.

QCCR1E103357

When you run an incorrect
command from a list details
page, a notification message is
not displayed.

A notification message is now displayed.

QCCR1E103869

There is no parameter or
property file for the sm -svc_
import command to determine
which directory or .xml file(s)
should be imported.

The following two parameters are introduced
to implement the functionality:
l

l

svc_files: "Comma separated list of files
for import/export operation."
svc_excludefiles: "Comma separated list
of files to exclude for import/export
operation."

QCCR1E110743

Records with the field type
"nvarchar(3000)" cannot be
added.

Such records can now be added successfully.

QCCR1E110742

Service Manager RTE cannot
save/load nvarchar fields
correctly.

The fields can now be saved/loaded correctly.

QCCR1E111801

Cyrillic characters in file names
of attachments are replaced by
spaces when Service Manager
gets the attachment using the
REST requests.

Cyrillic characters in file names of
attachments are encoded in UTF-8. These file
names are displayed correctly if the client
supports RFC6266.

QCCR1E112034

Memory leak issues occur if a
field type in SQL Server is defined
as "NCHAR".

The memory leak issues no longer occur.
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QCCR1E112412

In a grouped QBE list, after you
make modifications to a record
that change its group, the focus
jumps to the first record of the
QBE list.

If you make modifications to a record that
changes its group, the record still keeps the
focus no matter it is in QBE list or in the Todo
Queue. If you delete a record, the succeeding
record becomes the current row. If you
delete the last record, the preceding record
becomes the current row. This solution works
in QBE List mode, which is the default mode.
However, it doesn't work if the value of
viewrecordlist parameter is set to 0 in the
sm.ini file.

QCCR1E112414

The 9.34 Smart Analytics Content
Pack cannot be applied
successfully and RTE Signal 11
error messages are found in the
log.

The NULL pointer causes the signal 11 issue
and the issue is fixed now.

QCCR1E112475

Record locks remain on the
system after the system is shut
down.

Record locks are cleared after you run the
sm -unlockdatabase command and restart
the Service Manager service.

QCCR1E112582

When you click the Use Solution
button, the solution from the
Knowledge Management
document is incorrectly
formatted in the Solution field of
the interaction record.

Now the system can correctly convert and
into a carriage return and the information is
correctly formatted.

QCCR1E114304

After you create a view using the
JOIN query, the view works fine in
the details page. However if you
click any of the records listed in
the Menu navigator for that view,
all the records are displayed in
the tool.

Now if you click any of the records listed in
the Menu navigator for that view, only the
detailed information for the record specified
by the menu item is displayed.

QCCR1E114591

You cannot generate an index for
the fsyslib library.

You can now generate an index for the fsyslib
library.
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QCCR1E115291

When you click Knowledge
Management > Search
Knowledgebase > KM Doc Id to
search for a Knowledge
Management document, it takes
a long time (approximately 2 to 5
minutes), to open the document.

The waiting time to open Knowledge
Management articles is now acceptable.

The issue occurs for Knowledge
Management articles that have a
large number of attached files
and for all users including
Administrator.
QCCR1E115510

Incident search does not work
properly when you use the text
or check box variables in the
search criteria.

Incident search now works properly in this
case.

QCCR1E115679

If you do not set the
smtppassword parameter in the
"sm -emailout" command or the
sm.ini file, the emailout
functionality does not start up
successfully because of errors.

Now the emailout functionality starts up
successfully without the smtppassword
parameter being set.

QCCR1E116376

Signal 11 error messages are
found in logs after you perform a
binary update to 9.34.0032.

The issue that causes the errors is fixed. The
error messages can no longer be found in the
log file.

QCCR1E116652

When you load an unload that
contains the dbdict table again,
the system hangs.

The system no longer hangs in this case.

QCCR1E116873

The "SCFile.getAttachment"
JavaScript function does not
work.

The "SCFile.getAttachment" JavaScript
function now works as expected.

QCCR1E116887

Values in the "Counter" field in
the irqueue table do not increase
automatically. This causes
errors, and records are not
inserted in the table when keys
are converted to primary keys.

Now the counter field in the irqueue table is
updated with a value as expected, and
records are inserted without errors in the
irqueue table.
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QCCR1E117221

When lots of Java Exception are
thrown, JVM GC could not collect
the memory of these Java
Exceptions due to the RTE code
design limitation, therefore, the
Java Exceptions are accumulated
and an out-of-memory error
occurs.

Now if lots of Java Exception are thrown,
these exceptions are released by the RTE
code and no more Java memory leak errors
occur.

QCCR1E118284

The linker bg process crashes
because a signal 11 error occurs
in the getnumber() JavaScript
API.

Now there is no signal 11 error when the
getnumber() JavaScript API is called.

QCCR1E118562

The error message "Message:
Failed to retrieve request
details" is displayed when Service
Manager tries to show an
interaction in Service Request
Catalog.

The error message is no longer displayed in
this case.

QCCR1E118717

Data of the non-time types
shouldn't be displayed in the
drop-down list of the timestamp
field for Hot Topic Analysics
configuration.

Only the data of the time type is displayed in
the drop-down list now.

QCCR1E118880

When attachments are sent out
through REST API, file names
that contain non-ascii characters
can't be displayed correctly.

When attachments are sent out through
REST API, and file names contain only ascii
characters, please use the HTTP header:
Content-Disposition: attachment;
filename=plain-text-file-name, for example,
Content-Disposition: attachment;
filename=test1.txt.
If file names contain non-ascii characters,
please use the HTTP header: ContentDisposition: attachment; filename*=encodecharaset''encoded-text-file-name, for
example, Content-Disposition: attachment;
filename*=UTF8''%E6%99%93%E6%B9%984.txt.

QCCR1E119288

The Calendar page hangs when
you select dates and refresh
several times.

HP Service Manager (9.35)
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QCCR1E119853

Hot topic mandanten restricting
queries are set to be case
sensitive by default.

Now the case sensitivity of the queries is
decided by that of the corresponding
modules.

QCCR1E120010

In Service Manager RTE and
applications, the result of nullsub
(fax, "")="" is different between
version 9.33.0035 and 9.30.021
under Oracle RDBMS.

Now nullsub(fax, "")="" works correctly and
returns the same result for both Service
Manager versions.

QCCR1E120047

The "emailout servlet running
Process Low on Java Memory"
error message is displayed and
mails are no longer sent out.

Now this error does not occur.

QCCR1E120459

Service Manager RTE crashes
after you create a language
installer.

Now Service Manager RTE runs without any
exception.

QCCR1E120574

When users update a
changeTask by typing an invalid
value for the Date/Time field, the
value is cleared after they click
the Save button.

Now the value is retained after the Save
button is clicked.

QCCR1E120632

Smart Interaction OCR can only
save and display the extracted
image content in the Description
field. Tailoring is not supported.

Tailoring is now supported and Smart
Interaction OCR can save and display the
extracted image content in other fields.

QCCR1E120686

If groupname is set but ir_
asynchronous is not set in sm.ini,
IR searches in Service Catalog do
not work.

IR searches in Service Catalog now work as
expected.

QCCR1E121492

Numeric fields cannot be indexed
in Hot Topic Analytics.

Now the numeric field indexing functionality
is added for Hot Topic Analytics.

QCCR1E121732

SM servlet leave cluster, there is
no any message in SM log file

Now a message like "xxx is suspected of
having crashed" will be printed to log file

QCCR1E121761

A newly started node cannot be
found by load balancer
immediately

A newly started node can be found by load
balancer immediately

QCCR1E121823

When Service Manager converts
the unique key of the help table
to a primary key, a signal 11
error message is generated.

The signal 11 error message is no longer
generated.
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QCCR1E121969

Service Manager doesn't support
unique key in structure fields
when it extends a smart ticket to
the Change module.

Now Service Manager supports unique key in
structure fields when it extends a smart
ticket to the Change module.

Upgrade
CR

Problem

Solution

QCCR1E111997 The description labels "Replaced" and "Kept
Customer Non-OOB" are missing for the upgrade
result.

The labels are now added.

QCCR1E112766 The upgrade logs are incorrect when the upgrade
path does not end with "\" or "/".

The upgrade logs are now
correct even when the upgrade
path does not end with "\" or
"/".

QCCR1E114371 The value of the "Out of Box tables have been
deleted" indicator is not correct in the High Level
report.

The value of the indicator is
now correct.

QCCR1E115282 The assignment, contacts, and operator tables
must not be upgraded by the Upgrade Utility.

These tables are no longer
upgraded.

QCCR1E115451 The Upgrade Utility always displays the number
of records as 70 when it loads upgrade.mak
during the upgrading.

The number of records is now
displayed correctly.

QCCR1E116170 The Application build date is not correct after you
perform an upgrade.

The Application build date is
now correct.

QCCR1E117401 The Portuguese language is not changed to
Brazilian Portuguese after product upgrading.

Now the language is changed
after product upgrading.

QCCR1E117377 The Upgrade Utility cannot upgrade Service
Manager from a non-standard application
version.

Now the utility checks whether
the version is supported before
performing the upgrading.

QCCR1E117458 After you upgrade with the French language
package, Redundant Hebew and Indonesian
languages are displayed when you log in.

Now no redundant languages
are displayed after the
upgrading.
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QCCR1E120690 The following error message is displayed in the
message console during product upgrading:

The error message is no longer
displayed now.

Cannot evaluate expression
(apm.upgrade.revision.new.dbdict,
created.msg) Unable to locate
application \"sm.patchrel.log\"
(apm.upgrade.revision.new.dbdict,
created.msg)
QCCR1E120693 When you upgrade applications from
ServiceCenter 6.2 to Service Manager 9.34, the
following error message is generated:

The error no longer occurs
when your upgrade applications
from ServiceCenter 6.2.

API=OCIStmtExecute [in sqociExecOne],
Statement=INSERT INTO TODOLISTM1
("RECORD_ID", "STATUS", "DESCRIPTION",
"TARGET_DATE", "FOLDER", "URGENCY",
"PRIORITY", "GROUP", "A SSIGNEE",
"COMPANY", ITEMTYPE) SELECT
m1."INCIDENT_ID", m1."OPEN", m1."TITLE",
m1."NEEDED_BY_TIME", m1."FOLDER",
m1."SEVERITY", m1."PRIORITY_CODE",
m1."ASSIGNMENT", m1."O WNER_NAME",
m1."COMPANY", 'incidents' FROM
incidentsm1 m1 LEFT OUTER JOIN
incidentsm1 m1 ON m1."INCIDENT_ID" =
m1."INCIDENT_ID" WHERE not (m1."OPEN"
='Closed') AN D m1.RECORD_NUMBER=1
(apm.upgrade.todo,execute.insert.select)
SQL code=918 message=ORA-00918: column
ambiguously defined
(apm.upgrade.todo,execute.insert.select)

Web client
CR

Problem

Solution

QCCR1E92421

In Internet Explorer 9, the memory consumed
by a tab page keeps increasing when you
operate within the tab page (for example,
navigate through the record list).

Now the memory consumed by the
tab page increases reasonably
when you operate within the tab
page.
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QCCR1E93311

In the paging bar of the record list, the Show
combo box and its list items are not read
properly by JAWS.

Now the Show combo box and its list
items are read properly by JAWS.

When the maximum number of sessions on
the server is exceeded, you are redirected to
the goodbye page without any error
messages if you try to access the web tier.

Now you are redirected to a page
with the following error message if
you try to access the web tier:

When a message that contains line breaks
such as "\n" is displayed in a message box
generated by the RAD "mb.ok" in the web
client, the line breaks do not break the
message into multiple lines.

Now the line breaks break the
message into multiple lines.

QCCR1E96678

QCCR1E99709

Known issue: JAWS 13 recognizes
this combo box as a read-only
control, but JAWS 15 does not.

<Max Sessions Exceeded>.

QCCR1E101792 The drop-down list of the Jump Address
combo box overlaps with the Workflow
applet in the web client in Chrome.

Now combo box is not overlapped
with the Workflow applet.

QCCR1E102286 There is no timestamp for SOAP traces in the
Webtier log by default.

The timestamp is now appended for
SOAP traces in the Webtier log by
default.

QCCR1E103041 A Java security warning message is displayed
when you open the MySM page.

Now the MySM page can be
displayed without any warning
message.

QCCR1E103882 If your computer is set to a locale that
Now the value displayed is the day
implements Daylight Saving Time (DST), the
you selected.
clock is automatically adjusted for DST.
However, when you select the switch-over
date of DST through a calendar widget in the
web client, the value displayed is the previous
day.
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QCCR1E103935 In the Service Manager TSO environment, if
you set the IIS HTTP Redirect URL to the full
path of the web tier including index.do, for
example,
http://myhost.mydomain:8888/sm9.33.0035_
TSO/index.do, your attempt to access the
web tier fails with the following warning
message:

Solution
Now you no longer receive the
warning message.

The Service Manager main application is
already open in another browser tab or you
recently refreshed the current page. If
needed, save your work in the other tab first,
and then continue.
This warning message does not disappear
after you click the Continue button in the
message window.
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QCCR1E104398 The purpose of the frames used in the web
client is unclear to screen readers. If you use
JAWS key strokes to navigate frames in a
page, you always hear some meaningless
descriptions.

Solution
With the title attribute set for all
frames, the purpose of the frames
used in the web client is clear to
screen readers now.
The value of the title attribute
setting varies are determined by
the location of the frames as
described below:
1. For the frame in the detail-only
view or list-only view, it is the
header label of the current
active tab.
2. As to the frames in the listdetail view, it is the summary
of the record list for the frame
in the List pane, for example,
"Record List, Grouped by
Assignment Group, Sorted by
Open Time Ascending". And it is
the label for the current active
tab header for the frame in
the Detail pane.
3. For other invisible frame
without any content, it is
"Empty".
Known issue: Frames that are
invisible on the web page are still
visible to JAWS. This is an issue in
JAWS.

QCCR1E104754 A blank page is displayed if you set focus to a
read-only field of a record and press
Backspace.

Nothing happens if you set focus to
a read-only field of a record and
press Backspace.

QCCR1E111037 The new UI style is not applied to the log-out
page.

Now the style is applied.

QCCR1E111014 After you turn on the Windows High Contrast
mode, some controls, such as check boxes,
radio buttons, image buttons, sort indicators
in the Record list header, and submenu
indicators for the More action menu, are not
clearly visible in the web client.

Now except some controls in the
Process Designer and Calendar
module, all other controls are
clearly visible in the web client when
you turn on the Windows High
Contrast mode.
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QCCR1E112015 The focus style for the "Jump Address"
combo box is not consistent with the other
elements in the page in the accessible mode.

The focus style is now consistent
with the other elements.

QCCR1E112029 For an array of Comfills displayed in the
magnified table, if you type some strings in
one Comfill to call out the auto-completed
drop-down list and then press Esc key, the
magnified table disappears but the dropdown list does not.

Now both the drop-down list and
the magnified table disappear.

QCCR1E112853 If you design a form by adding a Table as the Now the table content is displayed
only control and use it as a subform by
only once.
selecting both the Virtual Join and the Display
Using Table attributes, and then use this
subform in another subform, the table
content is displayed twice when that form is
displayed in the Web client.
QCCR1E113023 Suppose you have an array variable that
stores two values, and in the Forms Designer
you assign the first value to the input
property of a read-only field and assign the
second value to the input property of an
editable field. If you then access the array in
the Web client through a related Display
Option record, the first value of the array is
always empty.

Now if you access an array of data
in the Web client through a related
Display Option record, each value in
the array is recognized correctly.

QCCR1E113457 The Box Line property does not work for the
Combo Box and Comfill controls. For example,
after you change the value of the Box Line
property for a Combo Box, the window size of
the drop-down list for the Combo Box
remains unchanged in the web client.

The Box Line property now works
for the Combo Box and Comfill
controls.

QCCR1E113417 If you change the branding configuration
"Main Page Header Background", the
background color of the Date Picker is
changed unexpectedly.

Now the background color of the
Date Picker remains unchanged.

QCCR1E113506 The value of a read-only Decimal control is
not displayed in the web client in the
accessible mode.

The value is now displayed in the
web client in the accessible mode.
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QCCR1E114282 The layout of the printed detailed
information of an incident record is not the
same as that in the details view. For example,
the Assignment Group field is not printed on
the same line as the Incident ID field.

The layout is now the same as that
in the detail view.

QCCR1E114504 If you input multiple lines of text into an
HTML Editor for a field whose data type is
array in the Web client and separate each
line with the Enter key, you can only view the
first line of the text after you save the
record.

The HTML Editor now supports array
values and you can view all lines of
the text.

QCCR1E114637 The property "Maximum Characters Beep"
does not work in the Web client.

The property now works in the Web
client that uses browsers other
than Internet Explorer 8.

QCCR1E114830 Suppose a Comfill control with the Auto
Complete feature enabled and a Subform
control with the Virtual Join feature enabled
share the same "input" field, if you change
the Comfill value through the Auto
Completed drop-down list, the content in the
Subform is not refreshed.

Now the content in the Subform is
refreshed accordingly.

QCCR1E114863 When you insert an ordered or an un-ordered
list in the HTML Editor, the Shift+Enter key
combination does not work correctly. Each
time when these keys are pressed, a
numbered or bullet item instead of an empty
item is created.

Now the key combination works
correctly.

QCCR1E115961 No text alternative is available for the HP
logo in the log-in page.

A text alternative is available for
the HP logo in the log-in page.

QCCR1E115986 The contrast ratio of the placeholders for the
two input text boxes in the log-in form does
not meet the requirement of Contrast
(Minimum) in the Web Content Accessibility
Guidelines (WCAG) 2.0.

The contrast ratio now meets the
requirement.

QCCR1E116055 The focus of the log-in button is not clearly
visible in the accessible mode.

Now the focus of the log-in button
is clearly visible.
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Limitation: Although each field is
kept in the same horizontal section
in the printed page as that in the
detail view, it is not exactly in the
same position as that in the detail
view.
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QCCR1E116047 If you use the Tab key to move focus inside a
table in the detail form, each cell of the table
gets focus one by one. There is no shortcut
key available to quickly move focus inside a
table.

Solution
For tables in the detail form, the
following shortcut keys are now
provided to move through table
cells quickly:
l

l

Ctrl + home/end: Move to
fist/last cell in the table
Home/End : Move to first/last
cell of current row
Note: When JAWS is running,
the shortcut keys do not work.
However JAWS has its own set
of shortcut keys to move
through the table. For example.
you can switch to table layer
by pressing Insert + Space,
followed by T, and then use Ctrl
+ Alt + Home/End to move to
first/last cell of table.

QCCR1E116111 The mandatory state displayed for a Date
control is inconsistent with that read by
JAWS.

The state is now consistent with
that read by JAWS.

QCCR1E116679 The Caption Condition for a control does not
work if its expression contains a reference to
an invisible field whose caption is also set
dynamically by using Caption Condition.

The Caption Condition for a control
now works correctly in this case.

QCCR1E116750 In Service Manager web client 9.33 or later,
when you modify an existing knowledge
document that were created with Internet
Explorer in earlier web client versions by
pressing Enter to add an item to an ordered
or un-ordered list, the new empty line does
not have a number or bullet.

Now the new empty line always has
a number or bullet.
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Limitation: This fix only works when
you define the invisible field as a
Text control. Other types like
Combo Box are not supported.

Note: The issue still exists for a
few old knowledge documents
with redundant HTML <div>
tags enclosed in the <li> tag. In
this case, you can work around
the issue by removing the
redundant <div> tags enclosed
in the <li> tag in the source
mode of an HTML editor.
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QCCR1E116845 If you set focus to a read-only field and press
the backspace key, the page refreshes
unexpectedly. In addition, if you continue
pressing the backspace key for multiple
times, you are logged out in some occasions.

If you set focus to a read-only field
and press the backspace key,
nothing happens now.

QCCR1E116847 The focus style is incorrect for the "Edit Cart"
link in the "Catalog Item" notebook tab of an
interaction record.

The focus style is correct now.

QCCR1E117120 After you log in to Service Manager via the
web client, you see some warning messages
in the webtier log file, regarding some
missing resources in the bundle
"com.hp.ov.cwc.web.cwc_labels".

Now you no longer see the
messages in the log file.

QCCR1E117200 If you use the default value 8 for the Box Line
property of a Comfill or Combo Box, they are
still displayed with 6 lines in the web client.

Now they are displayed with 8 lines
in the web client.

QCCR1E117607 The Caption condition does not work for the
read-only Comfill control.

Now the Caption condition works
correctly.

QCCR1E117998 If you log in to Service Manager via Trust Sign
On, you cannot see the "installed
components" displayed on the About page.

Now you can see the "installed
components" correctly displayed.

QCCR1E118793 Java applets do not work in Internet Explorer
if the JRE version on a computer is upgraded
to 1.7.0_71.

Java applets now work in the
Internet Explorer after the JRE
version on a computer is upgraded
to 1.7.0_75.

QCCR1E119067 If you set a read-only condition for a Dynamic
Form control, the read-only text fields and
text area fields inside them are displayed
with a white strip on both the left side and
the right side in the web client.

Now the fields are displayed with
correct background color.

QCCR1E119500 The line thickness of the focus indicator for a
table cell is too low in the accessible client.

The line thickness is now okay in the
accessible client.

QCCR1E119661 The new font-style does not have the maxage attribute and is not cached in the local
browser.

The new font-style now has the
max-age attribute and is cached in
the local browser.

QCCR1E119660 If the font files are not included in the
compression list, it takes the system a long
time to load the log-in page.

Now it takes less time for the
system to load the log-in page.
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QCCR1E119943 The smart ticket task page hangs when you
add multiple companies with a specific
character in the company code.

The smart ticket task page is
displayed correctly.

QCCR1E120524 There is no focus indicator for the OK or
Cancel button in the "Specify Image
Location" window in the Windows High
Contrast mode.

Now the focus indicator is available
for the OK or Cancel button.

QCCR1E120516 There is a dashed frame around the comfill
button after the focus leaves in Internet
Explorer 8.

There is no dashed frame around
the comfill button any longer.

QCCR1E120554 The label for "Field In Interaction" is not read
by JAWS in the "Add Filter Criteria" wizard
page.

After you take the value of the
"Name" property of the "Field In
Interaction" field and set it to the
"Label for" property of its label, the
label for the "Field In Interaction"
field is read by JAWS.
Note: If the "Input" for a label
is set with a variable, and this
label needs to be linked to a
widget, you must specify the
"name" of the target widget as
the "Label for" value for this
label.

QCCR1E120585 If the content to be displayed in an HTML
Viewer contains a link, and you set an
unquoted string for the href attribute of this
link, for example, <a href=http://abc.com>,
you are unable to print a form that contains
this HTML Viewer in the web client.

Now you can print the form
successfully.

QCCR1E120660 If you save an operator record without
changing the password in the Web client, the
following error message is sometimes
displayed:

Now the record is saved
successfully without any password
related error messages.

The entered password exceeds the maximum
length allowed.
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QCCR1E120859 In the Web client, search results with a
record list consume some memory in
Internet Explorer 9, and the memory is not
released after the search tab is closed.

Now in Internet Explorer 9, the
memory consumption gets big
improvement when you search
incidents and then close the search
tab.

QCCR1E120920 If you set an expression for the Visible
Condition property of a combo box or date
control, non-empty field values are displayed
as empty in the print preview page.

Now non-empty field values are
displayed correctly in the print
preview page.

QCCR1E121635 Tables in the detail form are not displayed in
the print view of Internet Explorer 8.

The tables are now displayed
correctly.

QCCR1E122133 JAWS does not read the required state
change triggered by the mandatory
condition.

JAWS reads the required state
change triggered by the mandatory
condition.

Windows client
CR

Problem

Solution

QCCR1E57084

If you input multiple lines of text into an HTML
Editor for a field whose data type is array in
the Windows Client by separating each line
with the Enter key, you can only view the first
line of the text after you save the record.

The HTML Editor now supports
array values and you can view all
the lines of the text.

QCCR1E105611

After you go through the records in the QBE list
in the Windows client, you might see the
following error messages in the file <user
home
directory>
\ServiceManager\workspace\.metadata\.log:
<[ERROR] Exception setting XML
Model:
java.lang.NullPointerException>

Now you no longer see these
error messages in the log file.

QCCR1E111821

In the windows client, suppose the current
focus is in an editable field (a Text, Combo box,
Comfill, or Decimal control). If you then move
focus into an HTML Editor and paste some
content into it, the previously focused editable
field also gets the pasted content.

Now the previously focused
editable field does not get the
pasted content.
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QCCR1E112030

If you use an array for the input property of
each column in a table, the array index may
not work. For example, "desc" is an array and
you design a table to use "desc, 2" for the
input of the first column, and "desc, 1" for the
second column. When the table is displayed in
the Windows client, the first column still uses
the first element of the array, and so does the
second column.

The array index now works in
this situation.

QCCR1E117587

If you configure the Windows client with the HP
Service Manager Client Configuration Utility to
hide server parameters, the Connections
Dialog is not automatically displayed when you
open the Windows client.

When you open the Windows
client, the Connections Dialog is
always automatically displayed,
even after you configure the
Windows client with the HP
Service Manager Client
Configuration Utility to hide
server parameters.

QCCR1E120739

The "Accessible Description" property is not
available for the "Graph" control.

The property is now available for
the "Graph" widget.
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Known problems, limitations, and workarounds
This software release has the following known issues and limitations. This is a cumulative list of known
issues and limitations in Service Manager, including those that are already documented in previous
release notes.

Issues in Service Manager 9.35
Global ID

Problem

Workaround

QCCR1E115514

The auto complete
functionality for the Comfill
control does not work
properly for the Link to
Parent Incident field of the
Incident from.

No workaround is currently available.

QCCR1E120737

The service filter in the
Interaction Hot Topic page
does not display a list of
values for user selection.

No workaround is currently available.

QCCR1E120360

The default value of the date
field cannot be submitted in
the Arabic version of Service
Request Catalog.

No workaround is currently available.

QCCR1E121885

A duplicated line appears
when you input some
characters in the HTML Editor.

You can use one of the options below to
solve the issue:
l

l
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Move the mouse out of the HTML Editor
for a while.
Click Source twice.
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QCCR1E122315

Users who use the LDAP
integration see the following
error message when they log
in to Service Manager 9.35 for
teh first time:

Click System Administration > Base
System Configuration > Miscellaneous >
System Information Record, Passwords >
Password Standards, and then clear the
Keep Password History check box.

The system requires you
to choose a new
password. That password
has been used before.
QCCR1E122316

For users who use the LDAP
integration, if their passwords
meet the LDAP password
policy but not the Service
Manager password policy,
they cannot log in to Service
Manager.

Click System Administration > Base
System Configuration > Miscellaneous >
System Information Record, Passwords >
Password Composition, and then make the
Service Manager password policy weaker
than the LDAP password policy.

QCCR1E122448

An error message is displayed
when users request a service
item from the Service
Request Catalog Hebrew user
interface and they cannot
submit the request
successfully.

You can create the service item in English
and then set the locale to Hebrew. After
that, users can submit requests for the item
from the Service Request Catalog Hebrew
user interface successfully.
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QCCR1E110999

Service Manager crashes
when you use the Open
Localization Toolkit to create
a language pack.

Update the OOB_UPG_COMPLETE message
and the CUSTOM_UPG_COMPLETE message
following the steps below:
1. Log in to Service Manager as a system
administrator.
2. Type db in the Service Manager
command line, and then press Enter.
The Database Manager opens.
3. Type scmessage in the Table field,
and then click Search.
4. Click message.edit.
5. Type upgin the Class field, type OOB_
UPG_COMPLETE in the Message
Number field, and then click Search.
6. Change the description in the Text field
to upgrade is only for
English version.
7. Click Save and OK.
8. Type upg in the Class field, type
CUSTOM_UPG_COMPLETE in the
Message Number field, and then click
Search.
9. Change the description in the Text field
to We need to update this
message. Otherwise, sm will
crash when create language
builder.
10. Click Save and OK.
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Issues in Service Manager 9.34 and patches
Global ID

Problem

Workaround

QCCR1E105375

Service Request Catalog does not
allow approval delegation for the
Time Period module.

No workaround is currently available.

QCCR1E106074

When you add custom multi-text
fields to the Service Checkout page,
the fields are not displayed
correctly on the Resubmit page on
an iPad.

No workaround is currently available.

QCCR1E107572

When you use the arrow keys to
move up, down, left, and right
through cells, JAWS reads "Not in
the table" incorrectly.

No workaround is currently available.

QCCR1E107573

When you put the focus on a
column header after you switch the
mode to table layer, JAWS reads
the names of the first column
header to the column header
currently in focus incorrectly.

No workaround is currently available.
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QCCR1E107712

In Internet Explorer 11, pressing F1
does not bring up the Service
Manager help information.

To work around this issue,follow these
steps:
1. Start Internet Explorer 11 from a
desktop computer, and then log in
to Service Manager.
2. Press Alt to access the menu bar in
Internet Explorer.
3. In the Tools menu, select
Compatibility View settings.
4. A dialog box appears, in which the
"Add this website:" field is
prepopulated with the host name or
IP address of your webtier host.
Click Add to add the website to the
compatibility view list.
5. Click Close. The Service Manager
web page refreshes and opens in
compatibility mode.

QCCR1E107983

In Google Chrome, you are unable
to use the Tab key to move the
focus to or off the HTML Editor.

No workaround is currently available.

QCCR1E108558

When "Virtual PC cursor" is enabled,
JAWS reads a group name three
times when you expand the group.

No workaround is currently available.

QCCR1E109151

The grouping grid changes to a
paging grid when you sort a table in
the "Select a Time Period category"
page.

No workaround is currently available.

QCCR1E109390

Revisions cannot be added when
you apply PDCP4 production data to
Service Manager 9.34 applications
that were upgraded from Service
Manager 9.32 applications.

No workaround is currently available.

QCCR1E109577

When you log in to the web client by
using Internet Explorer 8 for the
first time, all the characters are
displayed in an italic font.

Refresh the page in Internet Explorer.
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QCCR1E110285

When JAWS 15 runs in Internet
Explorer 10 or 11, the focus does
not return to the correct radio
button when you press Shift+Tab.

No workaround is currently available.

QCCR1E105370

The Quick Jump component is not
displayed in certain screen
resolutions.

No workaround is currently available.

QCCR1E110695

The MySM details page is not
displayed in Hebrew or Arabic.

No workaround is currently available.

QCCR1E110784

Sortable column headers for
editable tables do not have a sort
icon.

No workaround is currently available.

QCCR1E110085

JAWS reads the words "read only"
when the focus is on a language
combo box.

No workaround is currently available.

QCCR1E110343

The Auto Complete function does
not work for some fields of the
timeperioddefine format.

No workaround is currently available.

QCCR1E111031

The customized Accessible
Description for the recordlist table
in a wizard cannot be read by JAWS.

No workaround is currently available.

QCCR1E111202

When JAWS13 is working with Asian
languages such as Chinese,
Japanese or with the Arabic
language, the "System Navigator"
and "Pagination" navigations
cannot be listed in "Landmarks."

No workaround is currently available.

QCCR1E111084

You cannot use the keyboard to
operate on a List Builder control
when JAWS is running.

No workaround is currently available.

QCCR1E109267

The Label of the Parent Record
field cannot be displayed correctly
when saving an incident record.

No workaround is currently available.

QCCR1E110722

Accessibility to the Time period
rules table and the Time period
occurrences table is not good on a
time period record detail form.

No workaround is currently available.
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QCCR1E112188

If a Comfill field has Auto Complete
enabled and a data change event
(not 0) defined, and a post
expression/post JavaScript is
defined for the link for this field,
the data change event may not
work.

Do not enable Auto Complete for the
Comfill field.

QCCR1E110332

Calendar and Timeperiod in the
Module drop-down list item on the
SecArea Search page are not
translated.

Search for "securityModules" in the
global list, and then manually add
translated strings for the target
language.

QCCR1E111326

Cannot open timeperiod and entry
records in Embedded Calendar in
Internet Explorer 11.

Use an older version of Internet Explorer
or use a different browser such as
Firefox or Chrome.

QCCR1E111994

The Timeperiod Manager cannot
see the Approval Definition menu
when the system has no Process
Designer content pack applied.

To work around this issue,follow these
steps:
1. Log in to Service Manager Windows
client as a system administrator.
2. Type menu in Service Manager
Command line, and then press
Enter.
3. Type timeperiod in the Menu
Name field, and then click Search.
4. Locate the row with the description
of Approval Definitions.
5. Remove and jscall
("security.hasRight", "Common
Configuration","view")=true"
from the Condition field.

QCCR1E112097
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The Option menu is overlapped by
full calendar in the Service Manager
accessible web client.

No workaround is currently available.
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Global ID
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QCCR1E111131

Calendar and Timeperiod in the
Module drop-down list are not
translated in the Security Area
Search page. To see this issue,
follow these steps:

No workaround is currently available.

1. Log in to the web client with a
non-English language.
2. Go to System Administration
> Security > Security Area.
3. Click the "Module" drop-down
list.
QCCR1E119985

When you are updating an Incident,
if you input an invalid date time
value to the Outage Start or the
Outage End field, you cannot close
this incident tab by clicking the
Cancel button. The same problem
also happens when you are opening
a new Incident, opening a new
Change, or updating an existing
Change.

Correct the invalid input before you click
the Cancel button.

QCCR1E120076

On the wizard page of Approval
Delegation > Set Delegate, when
you input an invalid date time value
to the Valid From or the Valid To
field, the value will be cleared after
you click the Next button.

No workaround is currently available.

Issues in Service Manager 9.33 and patches
Global ID

Problem

Workaround

QCCR1E100136

After the installation of a language
pack, the Windows client, if running on
an Arabic Windows 2008, displays the
tooltips of the 'Added' and
'Forced'/'Updated' columns in the
content pack results as reversed.

No workaround is currently available.
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Global ID

Problem

Workaround

QCCR1E101782

In Trusted Sign-On (TSO) mode, if users No workaround is currently available.
log in to the web client with Simplified
Chinese in Internet Explorer 10 running
on Windows 8 or Windows 2012, the
web client still displays in English
instead of in Simplified Chinese.

QCCR1E103847

An arrow connector in a Process
Designer workflow might be
misaligned when the destination phase
is vertically too close to another phase
(this problem was introduced in
Service Manager 9.33 patch 1 revision
1).

To resolve the issue, move the
destination phase away enough from
the adjacent phase.

QCCR1E103858

It displays auto-open tasks in the task
planner window (this problem was
introduced in Service Manager 9.33
patch 1 revision 1).

No workaround is currently available.

Issues in Service Manager 9.32 and patches
Service Manager Issues
Global ID

Problem

QCCR1E64377 In the web client, when a Configuration
Item (CI) record is opened, the CI label
does not show (or only shows for the first
time) in the CI Visualization (Relationship
Graph). This issue occurs only when JRE 6
is used.
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Workaround
As Oracle has fixed this Applet issue, JRE
6 customers need to upgrade their JRE to
the latest JRE6 or JRE7 on the machine
that runs Internet Explorer or Firefox in
order for CI Visualization to display CI
labels correctly.
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QCCR1E95725 Due to a known issue in JDK (bug
id:7196513), CI icons are not displayed
correctly in Firefox when Httponly
cookies are enabled in the web
application server.

Workaround
When Httponly cookies are enabled,
users can only use Internet Explorer 7 or
higher for CI icons to display correctly. As
Oracle has fixed the Httponly cookie
issue as of JDK 7u6, users need to install
the latest 32-bit JRE (7u6 or above) on
the machine that runs Internet Explorer 7
or higher.
Note: In Service Manager 9.33, users
can only use Internet Explorer 8 or
higher for CI icons to display
correctly.

QCCR1E95963 An error occurs when loading a dbdict
Do not export to an unload file a dbdict
twice in an unload file. The two dbdict
record whose key type has changed.
records have the same name, but
different key types: the first one has
unique key, while the second's key type is
primary key.
QCCR1E97260 When SSL is enabled between the web
application server and Firefox, a ClassNot
found Exception error displays in the
workflow section of the Change form.
This issue does not occur in IE or in
Firefox without SSL enabled.

There are two workarounds:
l

l

Use Internet Explorer instead of
Firefox.
If using Firefox, import the client
certificate into the Java console on
the end user's machine. Here are the
steps for Windows 7:
a. Open Control Panel, and i n the
Control Panel Search box enter
"Java Control Panel".
b. Double-click the Java console
icon to open the Java console.
c. On the Security tab, click Manage
Certificates ....
d. On the Certificates window,
select certificate type: Client
Authentication, and click Import.
e. Follow the wizard and import the
client user's certificate.
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Global ID

Problem

QCCR1E97492 Clicking the Back button on the CI
Visualization page (which opens when
you click More > Expand CI Visualization
in a CI record) causes a Firefox crash.

Workaround
No workaround is currently available.

QCCR1E97603 If a format that contains a button with
Upgrade both of the Service Manager
Enable condition is created or modified
server and client to the same patch level:
by using a Service Manager 9.31 patch 1 Service Manager 9.31 patch 1 or later.
server, when using it in Service Manager
9.31 GA or earlier, the client crashes.
However, formats created by using the
Service Manager 9.31 GA or earlier server
work fine.
QCCR1E94657 When PDCP4 is applied, the first group on Move the scroll bar to the top-most
the form is not shown in the Jump
position and then you will see the first
Address drop down list.
group.
QCCR1E97856 In a single-line text field, some special
characters whose HTML code is &#x...;
(where ... stands for a hex number) are
not represented as their original format.
Instead, they display as &#x...;.
However, such characters are
represented as the original format in
other widgets (textarea, label, message
panel, and so on).

No workaround is currently available.

QCCR1E93604 The HTTP Response Code is 200 instead
of 400 when a RESTful request uses an
invalid sort field separator (for example,
a plus symbol).

Use a valid sort field separator.

QCCR1E94204 Because of the incorrect status, the
operation could not proceed after
merging a record.

Reset the status of this record (for
example, reopen the closed record) and
perform the last operation again.

QCCR1E94206 The last operation could not be repeated
after merging a record because the
button for the last operation disappears.

Reset the condition for the button in this
record, for example, Reopen the closed
record, and perform the last operation
again.

QCCR1E96353 RESTful API: An incident record is
successfully resolved when posting an
incident resolve action with a blank
"ClosureCode" and "Solution".

Validation is not performed for the fields.
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To work around this issue, validate them
at the RESTful client side, or manually
add validation for the fields to the
format control.
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QCCR1E96391 Restful API: Results are in the wrong
order when sorted by an array field.

Workaround
No workaround is currently available.

This issue occurs because the Service
Manager RTE does not support sorting by
array fields. A list is returned without any
error message.
QCCR1E97898 Restful API: A 400 Bad Request error
occurs when a RESTful API request is a
cross-table join query.

The RESTful API framework supports
simple queries and Service Manager
native queries.
Currently RESTful API framework does
not support cross-table SQL queries.

QCCR1E98320 When a record is removed after being
read, the Merge function still allows the
user to merge the record and the user's
input is lost.

No workaround is currently available.

QCCR1E98227 In Approval Delegation wizard, go to
another page (do not change the
delegation module) after choose the
operator to delegate in "Select Approval
Groups" page, then back to "Select
Approval Groups" page again. You will
find a blank line is displayed in the right
table, instead of the operator record.

This is only a display issue, and will not
impact the functionality. If you need to
remove the operator from the delegation
list, choose the blank line, and then click
the remove icon; otherwise the operator
will be successfully delegated once you
save the update.

QCCR1E98576 When there are conflicted updates on
system fields, the system displays the
message "The conflicted fields cannot be
merged. Reload the record.", whereas
the Merge button is available. Actually,
the merge function should not be
available in such case.

Ignore the Merge button. Reload the
latest record to edit this record again.

QCCR1E98398 When you are updating a record and
adding attachments to this record, if
your updates conflict with another users'
updates or the updates of a background
process, the attachments will be lost
after either automatic or manual merge.

After automatic or manual merge, add
the attachments again before saving the
merged result of the record.
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Global ID

Problem

QCCR1E98411 SRC failed to retrieve service catalog
items from Service Manager on upgrade
from Service Manager 7.11 to Service
Manager 9.32.

Workaround
In the svcCatalog dbdict, the id.attach
field is character type, which should be
number type. The id.attach field is an
alias of the id field in the svcCatalog
table.
To fix the issue, change the field type
using the Dbdict Utility.

QCCR1E98618 Subcategory data on the Incident form is
not available after upgrading from
ServiceCenter 6.2 to Service Manager
9.32.
Subcategory data is not upgraded.

If necessary, manually add the
subcategory data.
1. Enter db in the Service Manager
command line box.
2. In the Table field, enter
subcategory, and click Search.
3. For each Catagory in the dropdown
list, add the following Areas (enter a
value in the Area field and click Add):
access, data, failure,
hardware, performance, and
security.

QCCR1E98475 With Process Designer Content Pack
9.30.3 applied, the Merge functionality
does not work when a user clicks Save &
New in an interaction record opened
through a search.
1. Open an interaction through a
search.
2. Update the Title.

If you encounter the error "This record
has changed since you selected it." when
clicking the Save & New button on an
interaction opened through a search, to
avoid abandoning your updates, do not
use the Save & New button to save your
updates; instead, first click the Save
button to save your updates with the
merged result, and then register a new
interaction from the navigation menu.

3. Another back-end process has
updated the Title to another value.
4. Click Save & New. An error occurs:
This record has changed since
you selected it.
You cannot perform Merge for the
conflicted updates as expected.
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Service Request Catalog Issues
Global ID

Problem

Workaround

QCCR1E90074

When entering a search string in
Service Request Catalog, autocomplete does not work if the
browser's preferred language is set
to an East Asian language (for
example, Simplified Chinese).

No workaround is currently available.

QCCR1E98339

Custom fields do not load the
DEFAULT company value when the
checkout panel is empty for one of
the three checkout panels of your
company.

After upgrade, you should manually
add the same structure configuration
of the DEFAULT company for the
empty checkout panel of your
company. For example, before
upgrade, you, as an SRC administrator,
only defined custom fields for the
Service Catalog checkout panel for
your company. After upgrade to
Service Manager 9.32, if you want to
use the support checkout panel and
generic support checkout panel in SRC
correctly, you need to manually add
OOB configurations for the Support
Catalog and Generic Support checkout
panels, which you can copy from those
panels of the DEFAULT company.

QCCR1E103491

When SRC starts in FIPS mode, JCE
cannot authenticate the provider
JsafeJCE.

Replace cryptojce-6.1.jar and
cryptojcommon-6.1.jar in the SRC .war
files with those from the encryptor
tool folder in the same release
package.

Issues in Service Manager 9.31 and patches
Global ID

Problem

Workaround

QCCR1E63663

The Service Manager client loses
connectivity during JavaScript
execution of the file.list RAD
application.

No workaround available.
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Global ID

Problem

Workaround

QCCR1E57385

When Service Manager is running on
Unix, the legacy listener may log
intermittent signal 11 errors upon
CIT initial connectivity test if execshield is not set properly.

Use one of the following solutions to work
around this issue.
Solution 1:
Connect Connect-It to the Web Services
connector instead of the Legacy Listener
connector.
Solution 2:
Before connecting Connect-It to the Legacy
Listener connector, do the following:
1. Add usethreading:0 in the sc.ini file,
which is located in <Service Manager
server installation
path>\LegacyIntegration\RUN.
Note: For 64-bit RedHat Linux
servers only, you can alternatively
run the following shell commands
as root:
# sysctl -w kernel.exec-shield=0
# sysctl -w kernel.randomize_
va_space=0
2. Start the legacy listener.
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Global ID

Problem

QCCR1E67491

When the collation of the db
instance is Chinese_PRC_BIN, Web
service clients fail to connect to
Service Manager. Only ASCII operator
names are supported, so only ASCII
operator names can be used.

Workaround
Note: This issue only exists in Web
service integrations. Therefore, the
Service Manager clients do not have
this problem.
When Service Manager is handling an
incoming SOAP request, the authorization
string is decoded by BASE64Decoder. Service
Manager uses the decoded string value to
construct a UTF-8 string that is used in the
RTE. However, the authorization string is in
the header and Service Manager does not
know the charset or encoding of the
underling string value, which is BASE64
encoded.
Therefore, if the underlying string value is
not UTF-8, this problem will occur. In Service
Manager, when fetching an operator record
from the database, no matter what collation
the database uses, the operator record
finally will get a UTF-8 operator value.
However, even if users put the same value in
the authorization header, the operator
name may differ because of the
charset/encoding issue. Because of this, the
operator will fail to log on.
This is a limitation of Service Manager. Do
not use non-ASCII characters in operator
names. Created a knowledge article
(KM1442479) to document this limitation.

QCCR1E75182

HTML email truncates the body of
the message and sends the HTML
code without translating it.

When the content of an HTML email
template exceeds 8192 bytes in size, the
content will be truncated and displayed as
HTML code.
Make sure your HTML email templates do
not exceed this size limit.

QCCR1E77563

Signal 11 error is received when
calling the toXMLString() routine of
the Users object.
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Global ID

Problem

Workaround

QCCR1E88222

An unload file that is exported from
an Oracle to an SQL Server database
fails to import when the unload file
already contains a RECORD_KEY field
and the length of first unique key
exceeds the db limitation.

This request is caused by the product
running in an unsupported configuration.
Change to a documented and supported
configuration. If the problem still exists in a
supported environment, contact HP Support.
To work around this issue, do not use
"RECORD_KEY" as a SQL Name for a field in
dbdict. This field name is reserved by
Service Manager. To do this, follow these
steps:
1. Enter dbdict in the Service Manager
command line box, and then press
Enter.
2. Open the problematic dbdict which has
the "record.key" field defined.
3. Select the "record.key" field, and then
change the SQL Name from "RECORD_
KEY" to anything else.

QCCR1E74808

After clicking the Cancel button in
the Condition Editor from the
Workflow Editor, the current tab
sometimes becomes a blank screen
and the tab cannot be closed.

No workaround is currently available.

QCCR1E105052 In Task Planner, the tooltip of a task
displays the change phases with
their names instead of their display
names.

No workaround is currently available.
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Backup and backout instructions
In case you need to restore your HP Service Manager system to its original state after installing the
component patches in this release, make necessary backups before each patch installation. If a rollback
is needed, follow the backout instructions.

Server
Backup
Before you apply the server patch, make a backup of the server installation folder. For example,
C:\Program Files\HP\Service Manager 9.35\Server.
Note: If you have a horizontally scaled system, be sure to back up the server installation folder for
each server instance.

Backout
Service Manager has supported FIPS mode since version 9.32. To run Service Manager in FIPS mode, you
must upgrade your database to the 256-bit AES encryption algorithm. Once you change all of the
encrypted fields to use the new 32 character encryption, you cannot roll back the RTE and still read the
encrypted data.
After installing the patch, do the following to back out:
1. Stop the Service Manager server.
2. Remove the existing server installation folder.
3. Copy the backup folder back.

Note: Make sure that the embedded Tomcat is also replaced with the backup, because the
version of the embedded Tomcat may have dependency on a specific server version.
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Note: If you have a horizontally scaled system, make sure that every server instance is
replaced with its backup.

4. If you have also loaded platform unload files required for your server changes, you must also roll
back the application changes made by the unload files. See "Applications" on page 81.
5. For Unix-based platforms other than Linux, make a backup of your JRE if you have not yet
upgraded to JRE 7 or JRE 8.
6. Restart the Service Manager server.

Web tier
Backup
Before deploying the new web tier, make a backup of the following items:
l

web.xml

l

application-context.xml

l

log4j.properties

l

the folder specified in the customize-folder web client parameter

l

splash screen

l

style sheets

l

any other customizations you made, including your webtier-<version>.war (webtier-ear<version>.ear) file.

Backout
To roll back to the old web tier, follow these steps:
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1. Delete or uninstall the existing web tier.
2. Clear the cache of your web application server (for example, Tomcat).
3. Redeploy the old web tier.
4. Restore your old customizations.

Windows client
Backup
To back up the Windows client, follow these steps:
1. Make a backup of your Windows client home folder, for example,
C:\Users\<username>\ServiceManager. Your connections and personalized settings are stored in
this folder.

Note: This is the out-of-box home directory, and could differ from yours if you made changes
to <Client>\configuration\config.ini file. If so, back up the files from the location
specified in that file.

2. Make a backup of your certificate configuration files if any (Window > Preferences > HP Service
Manager > Security). For example, your CA certificates file and client keystore file.
Note: For version 9.34.p2 or later, make a backup of the keystore password preference file:
<workspace_dir>\.metadata\.plugins\org.eclipse.core.runtime\.settings\
com.hp.ov.sm.client.eclipse.base.prefs

Backout
To roll back to the old Windows client, follow these steps:
1. Uninstall the new Windows client.
2. Reinstall the previous Windows client.
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3. Restore your old Windows connections and configurations.

Applications
If you plan to upgrade your applications to this release level, make a backup of your database before
the upgrade, in case you need to restore your database after the upgrade. Creating a backup of the
entire database and restoring the database if needed is a better approach for a full applications
upgrade.
If you plan to load individual unload files in this release, follow the backup and backout instructions
below.

Backup
Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are recommended
to use Unload Manager to make a backup of the files to be modified by an unload file, because
Unload Manager can create a backup of your old data during the installation of the unload; if your
application version is other than any of these, Unload Manager is not available and you can use
Database Manager instead.
To use Unload Manager to make a backup, follow these steps:
1. Go to System Administration > Ongoing Maintenance > Unload Manager.
2. Double-click Apply Unload. A wizard opens.
3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details of
the unload file appear.
4. Double-click a conflicting object in the table to open the merge tool:
a. Merge the object, and then select the Reconciled check box.
b. Click Save to go back to the wizard.
5. Click Next after all the conflicting objects are reconciled.
6. Click Yes on the confirmation window to apply the unload.
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7. Click Finish.
Now, the unload has been applied and at the same time your old data backed up.
To use Database Manager to make a backup, follow these steps:
1. Go to Database Manager, select Import/Load from More or the More Actions menu, and browse to
the unload file.
2. Click List Contents on the menu bar, to view a list of files that have been updated in this unload.
See the following figure for an example.

This figure shows the contents of an unload file that contains changes to the following files:
File

Record

Process

svc.add.cart

application

money.format
Note: The scmessage records listed under each RAD application are
messages used in this RAD application; no backup is needed for them.
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File

Record

ScriptLibrary svcCartHelper
datadict

activity

dbdict

activity
Note: The “activity” file with no records actually represents the dbdict record
of the activity file.

scmessage

The record whose message class is “fc” and message number is 1000.

3. Go to Database Manager, in the Table field enter a file name you got in step 2, and click the Search
button.
4. If the format selection page shows, select the proper format by double-clicking it (for example,
select the device format for the device file), and then search for the file record.
5. Click More (or the More Actions menu) > Export/Unload after the file record displays.

Note: If Export/Unload is not available, check the Administration Mode check box in Database
Manager and try again.

6. In the pop-up window, specify your backup upload file path/name, and click Unload Appl.

Caution: Make sure that Append to file is selected.

7. Continue to follow steps 3 through step 6 to back up the rest of the files you got in step 2.

Backout
Tip: You can use Unload Manager (recommended) or Database Manager (if Unload Manager is not
available in your application version) to roll back to your old data, as described in the following.
To roll back to your old data using Unload Manager, follow these steps:
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1. Go to System Administration > Ongoing Maintenance > Unload Manager.
2. Double-click Apply Unload. A wizard opens.
3. Select the unload file generated in the backup process, specify a backup file, and then click Next.
Details of the unload file display.
4. Double-click a conflicting object in the table to open the merge tool:
a. Merge the object, and then select the Reconciled check box.
b. Click Save to return to the wizard.
5. Click Next after all the conflicting objects are reconciled.
6. Click Yes on the confirmation window to apply the backup unload.
7. Click Finish.
To roll back to your old data using Database Manager, follow these steps:
1. Go to Database Manager, click More > Import/Load.
2. Browse to the backup unload file you created.
3. Click Load FG.

SRC
Backup
Make a backup of the entire SRC installation folder.

Backout
Remove the new SRC installation folder and copy the SRC installation backup folder back to the web
application server.
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Knowledge Management search engine
To back out your Knowledge Management (KM) search engine changes, make a backup before your KM
patch installation.
Note: Keep in mind that you also need to roll back KM-related server side and application side
changes. For details, see the Server and Application backup and backout instructions.

Backup
Before applying the KM patch and upgrading the JDK and KM embedded Tomcat, do the following:
1. Make a backup of the search engine installation folder. For example, C:\Program Files\HP\Service
Manager 9.30\Search Engine Backup.
2. Make a backup of the files to be modified by the unload files in the KM patch.
3. Make a backup of your schemastub.xml file under the <SM server>/RUN/km/styles/ directory .

Backout
After installing the patch, follow these steps to backout:
1. Stop your KM search engine.
2. Remove the existing search engine installation folder.
3. Copy the backup folder back.
4. Rollback the previous JDK installation and change the JAVA_HOME environment variable back.
5. Be sure to roll back KM related changes on the Service Manager server and application sides,
including the kmsolr unloads files and the server's schemastub.xml file.
6. Restart your KM search engine.
7. Perform a full re-index on all of your knowledgebases.
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Installation notes
This section provides instructions on installing each component in this patch release. You can also refer
to the Service Manager 9.35 Installation and Upgrade Documentation Center, which is available to
download from the following HP Software Support Online (SSO) website:
https://softwaresupport.hp.com/group/softwaresupport/search-result//facetsearch/document/KM01294561
Before you proceed, HP recommends that you consult the latest Service Manager 9.35 Support Matrix
and the Compatibility Matrix for Service Manager Applications Content. These are available at the
following website:
https://softwaresupport.hp.com/group/softwaresupport/support-matrices

Digital signature notice
HP signs Windows executable files with a digital signature. Since January 2012, this process has been
updated to use a new VeriSign root certificate. On a Windows system that does not have the new
VeriSign root or intermediate certificate installed, when the user right-clicks the file and then goes to
Properties > Digital Signatures > Details, the following verification error is displayed:
The certificate in this signature cannot be verified.
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To resolve this issue, either enable Windows Update or download and install the G5 Root certificate as
documented at: https://knowledge.verisign.com/support/ssl-certificatessupport/index?page=content&actp=CROSSLINK&id=SO19140.

Server update installation
The server update for your operating system consists of a compressed file, sm9.35.0012_<OS>.zip (or
.tar), which contains updated files of the HP Service Manager server. These files add to or replace the
files in the [SM Server Root]\([SM Server Root]/)RUN, irlang, bin, legacyintegration, and platform_
unloads directories.
Note: If you use an Oracle RDBMS, be aware that Oracle Call Interface (OCI) 11.2.0.3 is required. For
more information, see the latest Service Manager 9.35 Support Matrix at this website:
https://softwaresupport.hp.com/group/softwaresupport/support-matrices

Built-in troubleshooting tool (SM Doctor)
Additionally, as of Service Manager 9.32, the server patch includes an installation of the HP Service
Manager Doctor (SM Doctor) tool. The server patch will install the tool in the <SM server root>\(<SM
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server root>/)smdoctor directory. For information on how to use this tool, see the Guides and reference >
Troubleshooting > HP Service Manager Doctor section in the Help Center.

Upgrade paths
This server patch must be applied on top of an earlier Service Manager 9.3x system.
The following server upgrade paths are recommended:
l

New customers: Install the Service Manager 9.30 GA server, and then directly apply this server
patch.

l

Existing SC6.2, Service Manager 7.11 and 9.21 customers: Uninstall the old server, install the
Service Manager 9.30 GA server, and then apply this server patch.

l

Existing Service Manager 9.3x customers: Apply this server patch.

For installation instructions of the Service Manager 9.35 server, see the Service Manager 9.35
Installation and Upgrade Documentation Center, which is available to download from the following HP
Software Support Online (SSO) website:
https://softwaresupport.hp.com/group/softwaresupport/search-result//facetsearch/document/KM01294561

Compatibility mode for installation on Windows Server
2012
As of Service Manager 9.32, Windows Server 2012 is supported. Be aware that compatibility mode is
required for installing the Service Manager 9.30 GA server on Windows Server 2012 (not required for
Windows Server 2008). To run your server installation in compatibility mode, perform the following
steps:
1. Right–click the server's setupwin32.exe file icon.
2. Click Properties > Compatibility.
3. Click Run this program in compatibility mode for, and then select Windows Vista (Service Pack
2).
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4. Click Apply, and then click OK.
5. Run the setupwin32.exe file to complete the installation.
When you uninstall your server on Windows Server 2012, you should also use compatibility mode. To do
this, set your Windows server uninstaller file (_uninst\uninstaller.exe) to compatibility mode as
described above, and then uninstall the server using the uninstaller or Control Panel.

Server patch installation steps
Caution:
l

The server patch will upgrade your embedded Tomcat to version 6.0.41, and therefore requires
additional steps.

l

The server patch will upgrade your JGroups (in the RUN/lib directory) to version 3.2.

l

For Windows and Linux, the server's embedded JRE has already upgraded to version 8; for other
Unix-based platforms, you need to manually perform this JRE upgrade.
The JRE upgrade will cause external web service calls over SSL to fail if the remote endpoint
does not support Server Name Indication (SNI), which is by default activated in JRE 7 and JRE 8.
Once Service Manager is upgraded to use JRE 7 or JRE 8, it starts to use SNI extensions during
the SSL handshake. If the remote endpoint does not support SNI, the web service call will fail
with an error message. To solve this issue, do either of the following:
n

Activate SNI at the remote end point (recommended)

n

If the remote endpoint does not support SNI extensions, and SNI cannot be activated, add
the following JVMOption<n> parameter either to the sm.ini file, or to the start command of
the servlet(s) in the sm.cfg file:
JVMOption2:-Djsse.enableSNIExtension=false

Note: If you have a horizontally-scaled system, you must upgrade all your server instances.
To install the new sever patch, follow these steps:
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1. Stop all Service Manager clients.
2. Stop the Service Manager server.
3. Make a backup of the Server installation directory. See also "Backup and backout instructions" on
page 78.
4. Delete the RUN/tomcat directory. Tomcat in this directory will be upgraded to version 6.0.41 after
the server patch is installed.
5. Delete the RUN/lib directory.
6. For Windows and Linux platforms, delete the RUN/jre directory.

Note: This is to avoid conflicts between the old JRE and new JRE.

7. Extract the compressed files for your operating system into the main Service Manager directory on
the server.

Note: Two packages are provided for HP-UX. Use sm9.35.0012_HPUX-IA64-ORCL12C.tar only
when an Oracle 12c database is used, and use sm9.35.0012_HPUX-IA64.tar in other cases.

8. For UNIX servers, set the file permissions for all Service Manager files to "755."
9. For the following Unix servers, manually upgrade to one of the following JRE versions, if you have
not already done so.
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a. Install an appropriate version of JRE for your platform.
Solaris 10, 11.1 JRE 7 (update 60 or greater)
Solaris 9

JRE 6 (update 20 or greater)

HP-UX

JRE 7 (JRE_7.0.09 or greater) or JRE 8

AIX

JRE 7 (SR6 FP1) or JRE 8
Caution: To use JRE 8, your AIX version must be one of the
following:
o

AIX7 7100-03 or later

o

AIX6 6100-07 or later

Caution: Service Manager can run on Solaris 9 with JRE 6. However, HP recommends that
you upgrade to Solaris 10 or 11.1 to take advantage of JRE 7. If you still want to run the
server on Solaris 9, an extra configuration is required. Without this configuration, when
you start the Service Manager server, the following error will occur:
" fatal: libm.so.2: open failed: No such file or directory. "
This is a fundamental problem of Solaris 9, because there is no " libm.so.2 " on Solaris 9,
while the Service Manager server requires this " libm.so.2 " to work. Use the following
configuration to avoid this issue:
i. Log in to server host as a root user.
ii. Run the following commands to create a link between limb.so.1 and limb.so.2:
n cd /usr/lib n ln - s libm.so.1 libm.so.2
iii. Run the export LD_ NOVERSION=1 command to set the environment variable LD_
NOVERSION.

b. Set your JAVA_HOME environment variable to point to the correct JDK (if you have JDK
installed) or JRE (if you have only JRE installed).
c. Execute \RUN\removeLinks.sh to remove the old symbolic links and then execute
\RUN\setupLinks.sh to create new symbolic links.
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d. Run the following command to check that the JRE version is correct:
RUN\jre\bin\java –version
10. If you have made any customizations/changes to the original RUN/tomcat folder, restore them in
the new RUN/tomcat folder.
11. Your old schemastub.xml file (in the <SM_Server_Home>\RUN\km\styles\ directory) has been
updated to a newer version. Either keep your old file by copying it back or keep the updated
version (a full reindex for the knowledgebases is then required).
12. Run the sm -unlockdatabase command.

Note: This step is required the first time you upgrade to 9.30p4 or later; it is also required
whenever you change the server’s IP address after your upgrade to 9.30p4 or later. The
purpose of this step is to prevent stale license information from being kept in the system. In a
scaling implementation, you can run this command from any one of your servers.

13. Restart the Service Manager server.
14. Restart the Service Manager clients.
15. Verify the version using either of the methods:
n

From the Windows client, click Help > About Service Manager Server. The server version should
be: Release 9.35.0012.
From the server's RUN folder, run the sm -version command. The server version should be:
Version: 9.35.0012

Web tier installation
The web tier update consists of a compressed file, sm9.35.0012_Web_Tier.zip, which contains the
installation files (both the .war and .ear files) that are required to install the HP Service Manager 9.35
web tier. Installing the new web tier will upgrade your web client to this release level.
For installation instructions, see the Service Manager 9.35 Installation and Upgrade Documentation
Center, which is available to download from the following HP Software Support Online (SSO) website:
https://softwaresupport.hp.com/group/softwaresupport/search-result//facetsearch/document/KM01294561
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New customers
You only need to install the new web tier using the .war or .ear file from the sm9.35.0012_Web_Tier.zip
file in this release.

Existing customers
To upgrade your web tier to this patch level, you must back up and uninstall your old web tier, and then
install the new web tier. The upgrade does not automatically save your web tier customizations. To keep
your changes, you must back up your customized files and restore your customizations in the new
deployment.
Note: If you plan to deploy the web tier on Tomcat 7.0 by using the Tomcat Manager, you must set
the max-file-size and max-request-size parameters (default: 52428800) in the <Tomcat 7.0_
Home>webapps\manager\WEB-INF\web.xml file to a value greater than the size of the web tier
.war file, otherwise the deployment request will be rejected because the web tier .war file exceeds
the default maximum values. This restriction does not exist in Tomcat 6.0.
To install the new web tier, follow these steps:
1. Make the necessary backups. For more information about how to do this, see "Backup and backout
instructions" on page 78.
2. Delete or uninstall the existing web tier .war (or the .ear) file.
3. Clear the cache of your web application server.
4. Deploy the webtier-9.35.0012.war (or .ear) file by following the instructions in the Service Manager
9.35 Installation and Upgrade Documentation Center.

Note: It is best practice to deploy with a unique context root. For example, /webtier-9.35.0012.

5. Use a diff utility to compare the new web tier’s web.xml file against your backed-up version to
ensure that any new parameters are properly merged into the files used in your final deployment.
Do this for application-context.xml as well as any other files you may have customized (such as
style sheets and splash screens).
6. Make any new customizations that are necessary for your deployment.
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7. Restart the web application server.
8. Check the version by clicking the HP logo (About HP Service Manager) icon.
The web tier version should be: 9.35.0012.

Windows Client Installation
Note: No features are being added to the Service Manager Windows (Eclipse) client. HP
recommends that Service Manager administrators deploy one of the other three clients (web
client, SRC client or Mobile Applications client) to end users. You still need the Windows client to
perform administrative tasks.
The Windows client update consists of a compressed file, sm9.35.0012_Windows_Client.zip, which
contains the executable installation files of the new Windows client. Installing the new Windows client
will upgrade your Windows client to this release level. This version of the Windows client comes with an
embedded JRE 8.
For installation instructions, see the Service Manager 9.35 Installation and Upgrade Documentation
Center, which is available to download from the following HP Software Support Online (SSO) website:
https://softwaresupport.hp.com/group/softwaresupport/search-result//facetsearch/document/KM01294561

New Customers
You only need to install the new Windows client.

Existing Customers
You need to back up and uninstall the old Windows client, and then install the new Windows client.
To install the new Windows client:
1. Stop the Service Manager Windows client.
2. Make necessary backups. For details, see "Backup and backout instructions" on page 78.
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3. Uninstall the Service Manager Windows client. (Your connection and personalized settings are
retained.)
4. Run setup.exe from this Windows client patch to install the new client.
5. Check the version in Help > About Service Manager Client.
The client should be Release: 9.35.0012.

Windows Client Configuration Utility installation
Service Manager 9.35 includes an updated version of the Windows Client Configuration Utility
(sm9.35.0012_Windows_Client_Configuration.zip). This version comes with an embedded JRE 8.
For installation instructions, see the Service Manager 9.35 Upgrade Documentation Center, which is
available to download from the following HP Software Support Online (SSO) website:
https://softwaresupport.hp.com/group/softwaresupport/search-result//facetsearch/document/KM01294561

Applications update installation
Note:
l

Upgrading your applications to version 9.35 is optional. Before upgrading your applications, you
must first upgrade your server and Windows or web client.

l

Upgrading your applications from 9.35 to 9.40 is not supported because Service Manager 9.40 is
released before 9.35.

You apply the 9.35 applications using either the Service Manager 9.35 Applications Patch Manager
(sm9.35.0012_Application.zip) or Upgrade Utility (sm9.35.0012_Application_Upgrade.zip)
depending on your current application version. You must also be aware of the dependencies if you have
already installed or plan to install Service Manager 9.3x content patches.
Upgrading to the 9.35 applications
Existing customers and new customers can upgrade to the 9.35 applications using different
approaches. For installation instructions, see the SM9.35 Installation and Upgrade Documentation
Center, which is available to download from the HP Software Support Online (SSO) website:
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https://softwaresupport.hp.com/group/softwaresupport/search-result//facetsearch/document/KM01294561
For existing customers:
1. Upgrade the Service Manager server and clients to version 9.35.
2. To upgrade from a 9.3x version of the applications, use the Service Manager 9.35 Applications
Patch Manager.
3. To upgrade from the 6.2, 7.11, or 9.21 applications, use the Service Manager 9.35 Upgrade Utility.
For new customers:
1. Install the Service Manager 9.30 GA server and load Service Manager 9.30 GA demo data.
2. Install the Service Manager 9.35 server patch.
3. Install the Service Manager 9.35 Windows or web client.
4. Upgrade to the Service Manager 9.35 applications using the Service Manager 9.35 Applications
Patch Manager.
Prerequisites
l

Service Manager applications release level
n

If using the Applications Patch Manager: 9.3x (9.30, 9.30 Applications Patch, 9.31, 9.32, 9.33, or
9.34)

n

If using the Upgrade Utility: 6.2, 7.1x, or 9.2x

l

Service Manager applications release language: Any languages supported by Service Manager 9.35

l

Service Manager client and server release level: 9.35 or greater

l

The Service Manager server process must have read-write access to the database

Content patch dependencies
Note: This release provides a PDCP4 compatibility unload file, which can resolve the conflicts that
occur after a Service Manager 9.3x system with Process Designer Content Pack 9.30.3 applied has
upgraded to applications version 9.35. You can download this unload file from the HP Live Network
website:
https://hpln.hp.com/
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For content patch dependency information, refer to the Compatibility Matrix for Service Manager
Applications Content document, which is available from the HP Support Matrices portal:
https://softwaresupport.hp.com/group/softwaresupport/support-matrices

Application unload installation
If a platform fix (in most cases, a server fix) also requires an applications change to resolve the relevant
issue, an unload file is provided. Unload files introduced in earlier patches are also included in this
cumulative release. If you have not already applied them for a previous patch, you should also apply the
unload files that are intended for your applications version. For more details about these applications
updates, see the Release Notes for those patches.
This patch release includes the unload files that come with the server update. When you extract
sm9.35.0012.zip (or .tar), it will add the files to the following directory:
[SM Server Root]\platform_unloads ([SM Server Root]/platform_unloads)
Note: Unload files should be installed in their patch order. That is, those introduced in patch 1
should be applied first, then those introduced in patch 2, and so on. However, unload files
introduced in the same patch can be installed in a random order, unless otherwise specified.
Unload file naming convention
The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where:
l

<CR_ID>: The identification number of the applications defect that the unload file fixes. For example,
QCCR1E12345.

l

SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For example,
SM921P2, which means the unload file comes with the server updates in Service Manager 9.21 patch
2 and should be used for patch 2 or higher.

Note: Sometimes this portion contains an additional hot fix number, for example,
SM711P16HF8. This example means the unload file is intended for Service Manager 7.11 patch
16 Hot Fix 8 or higher.

l

SMxxx: The Service Manager applications version that requires the unload file. For example, SM711,
which means the unload file is intended only for Service Manager applications version 7.11.
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Note: If the applications version suffix is omitted, the unload file is then intended for all
applications versions compatible with the server version, unless otherwise specified. For
example, QCCR1Exxxx_SM930P4.unl is normally intended for applications versions 7.11, 9.2x,
and 9.3x (which are compatible with Service Manager server 9.30), unless otherwise specified in
the unload file description. For information on the applicable applications versions for each
unload file included in the current patch, see Unload Files Included in the Current Patch.

Unload files included in the current patch
The following are unload files included in the current patch release.
Introduced
in 9.3x
patch

Used for
apps
version(s)

QCCR1E112070_
SM935_SM711.unl

9.35

7.11

Enables users to select multiple field values in
item options and save them to the cart item.

QCCR1E112070_
SM935_SM921.unl

9.35

9.21

Enables users to select multiple field values in
item options and save them to the cart item.

QCCR1E112070_
SM935_SM930.unl

9.35

9.30
through
9.34

Enables users to select multiple field values in
item options and save them to the cart item.

QCCR1E103456_
SM934_SM932.unl

9.34

9.32

Fixes this issue: When you use the "Any of these
words" text search option to export records to
Excel or to a text file, some records are not
exported.

Unload file

Description

Associated server fix: QCCR1E103456
QCCR1E103581_
SM934_SM932.unl

9.34

9.32

Fixes this issue: The auto complete feature is not
supported by the web client.
Associated server fix: QCCR1E103581

QCCR1E106292_
SM934.unl

9.34

7.11
through
9.34

Fixes this issue: The globallist and locallist files
are not cached. This causes heavy database
traffic during the login process, especially when
the globalist or locallist file is large.
Associated server fix: QCCR1E106292

QCCR1E112815_
SM934P1_
SM934.unl

9.34p1

9.34

Fixes this issue: The Time Period Management
menu and sub-menus are not displayed after
upgrading to Service Manager 9.34.
Associated server fix: QCCR1E112815
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Unload file
QCCR1E114378_
SM934P2_
SM932.unl

Introduced
in 9.3x
patch

Used for
apps
version(s)

9.34p2

9.32

Description
Fixes this issue: The Auto complete feature needs
RTE to change the line value of cursor.line to the
value of the line when calling
cursor.field.name.set.
Associated server fix: QCCR1E114378

QCCR1E99147_
SM933_SM930.unl

9.33

9.30, 9.31,
and 9.32

Fixes this issue: The first tab of a Notebook is
reset to be the active tab when a new interaction
is opened through the "Return to blank
interaction" environment settings.
Associated server fix: QCCR1E99147

QCCR1E99398_
SM932P2.unl

9.32p2

7.11, 9.21,
9.30, and
9.31

Enables the inactivity timer function to work
correctly when the version of applications is lower
than the version of the server.
Associated server fix: QCCR1E99398

QCCR1E19946_
SM933.unl

QCCR1E31324_
SM932.unl

9.33

9.32

7.11, 9.21,
9.30, 9.31,
and 9.32

Enables extra columns in the "Attachments"
section of records.

7.11, 9.21,
9.30 and
9.31

Fixes this issue: With Syslog audit turned on, only
a syslog record showing login is created; no
record for logoff is recorded if the user does not
log out "normally."

Associated server fix: QCCR1E19946

Associated server fix: QCCR1E31324
QCCR1E96802_
SM931P3.unl

9.31p3

7.11, 9.21,
9.30, and
9.31

Changes the behavior when handling web service
request user passwords. See the Service Manager
9.31p3 Release Notes.
Associated server fix: QCCR1E96802

QCCR1E52767_
SM931P3_
SM930.unl

9.31p3

9.30

Fixes this issue: Users cannot add data policy
definitions on joined tables.
Note: You do not need to load this unload if
you are running on Service Manager 9.31,
9.21, or 7.11 applications.
Associated server fix: QCCR1E52767
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Unload file
QCCR1E76724_
SM931P2_
SM930.unl

Introduced
in 9.3x
patch

Used for
apps
version(s)

9.31p2

9.30 and
9.31

Description
Fixes this issue: After deleting the unique key of
cm3r, a signal 11 happened while doing an IR
regeneration.
Associated server fix: QCCR1E76724

QCCR1E76227_
SM930P6_
SM930.unl

9.31

9.30

Contains the code changes to support localization
of incident/change priority and urgency strings
for the 9.31 Mobile Applications Client.
Note: Not needed for the Service Manager
9.32 or later Mobile Applications client.

QCCR1E78794_
SM930P6_
SM930.unl

9.31

9.30

Removes incident.assignee when a Web Service
call specifies the assignee as 'NULL' through the
Service Manager9.31 Mobile Applications Client.
Note: Not needed for the Service Manager
9.32 or later Mobile Applications client.

QCCR1E76796_
SM930P6_
SM930.unl

9.31

9.30

Provides the ability to turn on debugging
dynamically for user sessions or schedulers.
Note: This unload requires the Service
Manager 9.31 server.

QCCR1E71099_
SM930P5_
SM711.unl

9.30p5

7.11

Displays Value Lists instead of the data directly
retrieved from the database in a QBE list when
adding a field by using Modify Columns.
Associated server fix: QCCR1E71099

QCCR1E71099_
SM930P5_
SM920.unl

9.30p5

9.20

Displays Value Lists instead of the data directly
retrieved from the database in a QBE list when
adding a field by using Modify Columns.
Associated server fix: QCCR1E71099

QCCR1E71099_
SM930P5_
SM930.unl

9.30p5

9.30

Displays Value Lists instead of the data directly
retrieved from the database in a QBE list when
adding a field by using Modify Columns.
Associated server fix: QCCR1E71099
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Introduced
in 9.3x
patch

Used for
apps
version(s)

QCCR1E71139_
SM930P5_
SM930.unl

9.30p5

9.30

Works with server fix QCCR1E71139 to solve this
issue: When Service Manager is configured to use
LDAP as the authentication data source, the user
is still forced to change the password if the user
is expired in the local database.

QCCR1E31941_
SM930P4_
SM930.unl

9.30P4

9.30

Enables users to use a pre-configured decimal
symbol when completing numeric fields.

Unload file

Description

Note: This enhancement requires a 9.30p4 or
later server; however if you are using RTE
version 9.30 with applications version 7.11 or
9.20, do not load this unload file; you can
safely upgrade your server to 9.30p4 or later
without applying this applications change.
Associated server fix: QCCR1E31941.
QCCR1E73452_
SM930P4.unl

9.30P4

7.11 trough Enables Mandanten restricting queries to be
9.30
updated correctly after a profile is edited.
Associated server fix: QCCR1E71897

QCCR1E67072_
SM930P4_
SM930.unl

9.30P3

7.11 and
9.20

Enables users to take advantage of the new
KMStatusListener background process.
Note: This unload file is not needed for
applications version 9.30 or later, which
supports only the Solr Search Engine.
Associated server fix: QCCR1E67071

QCCR1E70163_
SM930P4_
SM711.unl

9.30P3

QCCR1E70163_
SM930P4_
SM920.unl

9.30P3

QCCR1E70163_
SM930P4_
SM930.unl

9.30P3
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7.11

Fixes this issue: The KMUpdate process
terminates abnormally.
Associated server fix: QCCR1E69687

9.20

Fixes this issue: The KMUpdate process
terminates abnormally.
Associated server fix: QCCR1E69687

9.30

Fixes this issue: The KMUpdate process
terminates abnormally.
Associated server fix: QCCR1E69687
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Unload file
QCCR1E67647_
SM930P3.unl

Introduced
in 9.3x
patch

Used for
apps
version(s)

9.30P3

7.11
through
9.30

Description
Updates the exception message that occurs in
the request response when closing an interaction
by calling CloseInteraction from a web service
without specifying the localSolution field in the
request.
Associated server fix: QCCR1E54192

QCCR1E67610_
SM930P2.unl

9.30P2

7.11
through
9.30

Enables you to block potentially dangerous
attachments.
Associated server fix: QCCR1E64290

Loading unload files
Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are recommended
to use Unload Manager to load an unload file, because Unload Manager can help you create a
backup of your old data and reconcile conflicts during the installation of the unload; if your
application version is other than any of these, Unload Manager is not available and you can use
Database Manager instead.
To load an unload file using Unload Manager, follow these steps:
1. Go to System Administration > Ongoing Maintenance > Unload Manager.
2. Double-click Apply Unload. A wizard opens.
3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details of
the unload file appear.
4. Double-click a conflicting object in the table to open the merge tool:
a. Merge the object, and then select the Reconciled check box.
b. Click Save to go back to the wizard.
5. Click Next after all the conflicting objects are reconciled.
6. Click Yes on the confirmation window to apply the unload.
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7. Click Finish.
Now, the unload has been applied and at the same time your old data backed up.
To load an unload file using Database Manager, follow these steps:
1. Make sure the Windows client is configured for server-side load/unload.
a. From the Windows client, go to Window > Preferences > HP Service Manager.
b. Unselect Client Side Load/Unload if is flagged.
c. Restart the Windows client.
2. Open Tailoring > Database Manager.
3. Right-click the form or open the More Actions menu and select Import/Load.
4. Browse to the unload file, and view the contents of an unload file before importing it by clicking
List Contents.
5. Make a backup copy of all files to be modified by this unload. For detailed steps, see "Backup and
backout instructions" on page 78.
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6. Fill in the following fields.
Field

Description

File Name

Type the name and path of the file to
load.

Import Descriptor

Since unload files do not require an
Import Descriptor record, leave this field
blank.

File Type

Select the source operating system of
the unload file.

Messages Option — All
Messages

Select this option to see all messages
that Service Manager generates loading
the file.

Messages Option — Totals Select this option to see only the total
Only
number of files Service Manager loads.
Messages Option — None

Select this option to hide all messages
that Service Manager generates when
loading the file.

7. Click Load FG.

Smart Analytics installation
The SmartAnalytics installation packages sm9.35.0003_SmartAnalytics_Windows.zip and sm9.35.0003_
SmartAnalytics_Linux.tar respectively contains the installation files for Windows
(setupSmartAnalyticsWindowsX64.exe) and Linux (setupSmartAnalyticsLinuxX64.bin).
For installation and configuration instructions, see the Smart Analytics Administrator and User Guide,
which you can access from the Installation and Upgrade Documentation Center document or from the
online help.

New customers
Install and configure Smart Analytics 9.35 by following the instructions in the Smart Analytics
Administrator and User Guide.
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Existing customers
Customers who have installed Smart Analytics 9.34 must back up certain configuration files and data,
reinstall Smart Analytics 9.35, and then restore the original configurations. For details, see the Smart
Analytics Administrator and User Guide.

Service Request Catalog (SRC) installation
Service Manager 9.35 includes the SRC package (sm9.35.0156_SRC.zip), which contains the following
files:
l

The .war file for SRC 9.35 (src-9.35.war)

l

The migration tool for upgrading customizations from an earlier SRC deployment to SRC 9.35 (srcmigration-9.35.zip)

l

The encryption tool for generating an encrypted password (encryptor-9.35.zip)

l

The validation tool that you can use to help ensure that your manifest.xml file is valid and usable
(validator-9.35.zip)

l

Documents, including the new Help document for SRC 9.35 (SRC9.35_Help_Center.zip)

Note: The English version of the online help provided in this package is for SRC 9.35, while the
non-English versions are for SRC 9.32 and do not include updates for new features introduced in
later versions of SRC.

Before you proceed, download the Service Request Catalog 9.35 Interactive Installation Guide and Service
Request Catalog 9.35 Customization Guide from the following HP Software Support Online (SSO) website:
https://softwaresupport.hp.com/group/softwaresupport/search-result//facetsearch/document/KM01294561
These guides provide details about deploying the .war file and the usage of the three tools.
Note: Service Manager 9.35 provides a new version of the HP Service Request Catalog app. Users
who want to use Service Request Catalog on their tablet devices can download the HP Service
Request Catalog app to their device from Google Play or the Apple Appstore. To locate this app,
search for "HP SRC" in the appropriate store.
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New Customers
1. Install SRC 9.35, deploy the src-9.35.war file by following the instructions in the Service Request
Catalog 9.35 Interactive Installation Guide.
2. Configure SRC 9.35 by following the instructions in the Service Request Catalog 9.35 Customization
Guide.

Existing Customers
1. Install SRC 9.35, as described above.
2. Migrate the customizations from your old deployment to SRC 9.35.
n

SRC 1.4 and SRC 9.3x customers: Run the SRC migration tool to migrate your specific
customizations from your old SRC deployment to SRC 9.35. For details, see the Service Request
Catalog 9.35 Customization Guide.

n

SRC 1.2x or 1.3 customers: Manually restore your customizations.

Using the SRC tablet application
Users who want to use Service Request Catalog on their tablet devices can download the HP Service
Request Catalog application to their device from Google Play or the Apple Apps Store. To locate the SRC
application, search for "HP SRC" in the appropriate store.
For the versions of Service Request Catalog (the SRC .war file) that the HP Service Request Catalog
tablet application supports, refer to the Support Matrix document.

Mobile Applications installation
Service Manager 9.35 includes a new version of the Mobile Applications client (sm9.35.0001_
Mobility.zip). This package includes the following files:
l

Mobile Applications client deployment .war file (webapp-9.35.0001.war)

l

Mobile Applications client self-service user interface unload for applications version 9.32 or later
(MOBILITY_ESS_SM935_SM932.unl)

l

Unload files for applications versions 9.30 and 9.31 (mobile2-update-9.30-9.31.unl, mobile2-new9.30-9.31.unl, and mobile2-new-9.31-pd4.unl)
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New customers can directly install the new Mobile Applications client by deploying the webapp9.35.0001.war file, while existing customers can only uninstall their old Mobile Applications client and
then install the new one.

Installation instructions
Note: The Service Manager 9.35 Mobile Applications client supports Apache Tomcat 7.0 (7.0.54 or
greater) and IBM WebSphere 8.5 (8.5.5 or greater) web application servers.
For more information about how to install the Service Manager 9.35 Mobile Applications client, refer to
the Service Manager 9.35 Mobile Applications User Guide.

Enabling the Mobile Applications client when running applications versions 9.31 and 9.30
The Service Manager 9.35 Mobile Applications client can work with the SM9.3x applications (9.30 through
9.35); however, if you are running the SM9.31 or SM9.30 applications, before users can use the Mobile
Applications client, you need to make additional application changes by either importing or manually
implementing the following unload files in listed order:
l

mobile2-update-9.30-9.31.unl

l

mobile2-new-9.30-9.31.unl (If using the SM9.31 or SM9.30 applications with PDCP4 applied, load
mobile2-new-9.31-pd4.unl instead)

For more information, see the Service Manager 9.35 Mobile Applications User Guide.

Enabling the Mobile Applications ESS user interface when running applications 9.3x earlier
than 9.35
The Service Manager 9.35 Mobile Applications client has already an employee self-service (ESS) user
interface enabled when working with the Service Manager 9.35 server and applications.
If you have upgraded your server to version 9.35 and are still running the 9.32, 9.33 or 9.34 applications,
you must load the MOBILITY_ESS_SM935_SM932.unl file to enable this interface.
If running Service Manager applications 9.30 or 9.31, to enable the ESS interface, you must enable the
Mobile Applications client for users first as described above, and then load the MOBILITY_ESS_SM935_
SM932.unl file.
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Knowledge Management (KM) Update Installation
Service Manager 9.35 does not contain any updates to the Knowledge Management (KM) module. The
latest SM9.3x KM package is the Service Manager 9.34 KM package.
The installation steps of the KM package are basically the same as those documented in the Service
Manager 9.34 Release Notes, except that the optional Tomcat and JDK upgrade steps in the KM Search
Engine installation section need to be adjusted to use Tomcat 6.0.41 (instead of 6.0.36) and JDK 8
(instead of JDK 7). Tomcat 6.0.41 and JDK 8 have been certified for the KM search engine in this release.

ODBC Driver update installation
This release does not contain any ODBC Driver updates. The latest ODBC Driver package has been
shipped with the HP Service Manager 9.30p4, 9.30p5, and 9.31 releases.
You can find the download links for the SM9.3x patches and release notes from the Overview of Service
Manager 9.3x Releases knowledge document:
https://softwaresupport.hp.com/group/softwaresupport/search-result//facetsearch/document/KM00705452

Language pack installation
Service Manager 9.35 includes a language pack package (sm9.35.0004_LanguagePack.zip). You can find
the download link of this language pack package from the Overview of Service Manager 9.3x Releases
knowledge document:
https://softwaresupport.hp.com/group/softwaresupport/search-result//facetsearch/document/KM00705452
Unlike in previous releases, the language packs for all supported languages in this release are provided
in the same package. When you install the language pack package, the languages that are already
installed in your system are automatically detected and selected by default. You can choose to install all
selected languages or some of them.
For installation instructions, see the Service Manager 9.35 Language Pack Installation Guide, which you
can download from the following HP Software Support Online (SSO) website:
https://softwaresupport.hp.com/group/softwaresupport/search-result//facetsearch/document/KM01294561
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Online help installation
Service Manager online help
Service Manager 9.35 includes only an English version of the online help. For installation instructions,
see the Service Manager 9.35 Interactive Installation Guide, which is available to download from the
following HP Software Support Online (SSO) website:
https://softwaresupport.hp.com/group/softwaresupport/search-result//facetsearch/document/KM01294561

Service Request Catalog (SRC) online help
The SRC online help is accessible from the product user interface. The English version is for SRC 9.35,
and the non-English versions are for SRC 9.32.
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:
Feedback on Release Notes (Service Manager 9.35)
Just add your feedback to the email and click send.
If no email client is available, copy the information above to a new message in a web mail client, and
send your feedback to ovdoc-ITSM@hp.com.
We appreciate your feedback!
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